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RINGKASAN 

 

Efektivitas Fraksi Air Umbi Bidara Upas (Merremia mammosa (Lour.)) pada 

Penyembuhan Luka Tikus Diabetes melalui Ekspresi VEGF; Haqiqotul 

Fikriyah, 152010101082; 2019; 125 halaman; Jurusan Pendidikan Dokter Fakultas 

Kedokteran Universitas Jember. 

 

Kadar gula darah yang tinggi pada pasien diabetes melitus mengakibatkan 

beberapa komplikasi, salah satunya yaitu luka diabetes. Luka tersebut dapat  

menyebabkan amputasi jika tidak ditangani. Terapi medikamentosa yang ada untuk 

menangani luka diabetes ialah berupa antibiotik topikal gentamicin. Namun, obat 

ini memiliki beberapa efek samping sehingga dibutuhkan obat alternatif lain untuk 

luka diabetes. Pada luka diabetes proses penyembuhan lebih lama dikarenakan 

adanya faktor-faktor yang disebabkan oleh tingginya kadar gula darah tersebut. 

Fraksi air umbi bidara upas (Merremia mammosa (Lour.)) mempunyai kandungan 

senyawa aktif seperti flavonoid, tanin, alkaloid, dan resin glikosida yang 

bermanfaat pada penyembuhan luka. Angiogenesis adalah sebuah proses 

pembentukan kembali kapiler-kapiler darah yang rusak yang penting dalam proses 

penyembuhan luka. Proses ini penting untuk oksigenasi dan suplai nutrisi pada 

jaringan yang baru terbentuk. VEGF merupakan salah satu growth factor 

proangiogenik yang penting pada proses angiogenesis. Tujuan dari penelitian ini 

yaitu mengetahui efektivitas fraksi air umbi bidara upas (Merremia mammosa 

(Lour.)) pada penyembuhan luka tikus diabetes dalam berbagai dosis dilihat dari 

ekspresi VEGF. Efektivitas dilihat dari adanya perbedaan ekspresi VEGF pada 

pemberian dosis fraksi air umbi bidara upas pada luka tikus diabetes. 

Pada penelitian ini digunakan jenis dan rancangan penelitian true 

experimental labolatories dan post test only control group design. Terdapat 

beberapa kelompok dengan pemberian perlakuan secara topikal yaitu kontrol 

negatif (aquadest), positif (gentamicin 0,1%), kelompok dengan pemberian 12,5 

mg, 25 mg, 50 mg, dan 100 mg faksi air umbi bidara upas. Perlakuan diberikan 

pada total 24 luka tikus diabetes 2 hari sekali pada hari ke-1 hingga ke-10 setelah 
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pemberian eksisi berukuran 2x2 cm2. Setelah hari ke-10, dilakukan pengambilan 

jaringan kemudian dilakukan pewarnaan imunohistokimia untuk mengetahui 

ekspresi VEGF. Hasil dari perhitungan ekspresi VEGF dihitung pada software 

ImageJ, dimasukkan pada sistem skoring histologi (lemah 1; sedang 2; kuat 3) dan 

hasil skoring dianalisis melalui software statistik dengan menggunakan uji One 

Way ANOVA dan uji Post Hoc LSD.  

Hasil yang didapatkan yaitu bahwa ekspresi VEGF terendah hingga 

tertinggi yaitu T1 (42,38), K(-) (42,84), K(+) (62,08), T2 (66,97), dan T4 (111,61). 

Hasil uji One Way ANOVA menunjukkan p<0,001, kemudian dilakukan uji Post 

Hoc LSD dan didapatkan kelompok K(-) berbeda signifikan dengan T2, T3 dan T4. 

Kelompok T1 berbeda signifikan dengan T2, T3, dan T4. Kelompok T2 memiliki 

perbedaan bermakna dengan kelompok K(-), T1, dan T4. Kelompok T3 berbeda 

signifikan dengan kelompok K(-), T1, dan T4. Kelompok T4 berbeda signifikan 

dengan seluruh kelompok lain. Kelompok kontrol positif mempunyai perbedaan 

signifikan dengan kelompok T4 (p≤0,001).  

Berdasarkan hasil pengamatan di atas maka dapat disimpulkan bahwa 

terdapat perbedaan ekspresi VEGF pada pemberian fraksi air umbi bidara upas 

dalam berbagai dosis. Hal ini dikarenakan terdapat senyawa-senyawa aktif yang 

memungkinkan terjadinya penyembuhan luka diabetes yang ditandai dengan 

peningkatan ekspresi VEGF, seperti flavonoid, tanin, alkaloid, dan resin glikosida. 

Peningkatan ekspresi VEGF dapat mempercepat penyembuhan pada luka tikus 

diabetes.  
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BAB 1. PENDAHULUAN 

 

1.1 Latar Belakang 

Diabetes mellitus (DM) merupakan suatu kelompok penyakit metabolik 

dengan karakteristik hiperglikemia yang terjadi karena kelainan pada sekresi 

insulin, kerja insulin atau keduanya (Purnamasari, 2014). Pada 2014 diperkirakan 

terdapat 422 juta orang dewasa hidup dengan DM, jumlah tersebut lebih besar jika 

dibandingkan dengan penderita pada tahun 1980 yaitu sebesar 108 juta (WHO, 

2016). Menurut International Diabetes Federation (IDF) (2017), Indonesia 

menempati peringkat ke-6 penderita DM tertinggi di dunia yang penderitanya 

mencapai 10,3 juta orang dengan rentang umur 20-79 tahun dan diperkirakan akan 

mencapai jumlah 16,7 juta pada tahun 2045. Selain itu DM menjadi penyebab 

kematian dari 1,6 juta orang di dunia pada tahun 2015 dan diprediksi akan menjadi 

penyebab kematian utama ketujuh pada 2030 (WHO, 2017). 

Kadar gula darah yang tinggi pada pasien DM mengakibatkan beberapa 

komplikasi, salah satunya yaitu luka diabetes. Adanya perubahan metabolik pada 

penderita DM secara langsung menyebabkan efek pada jaringan neural, sedangkan 

perubahan neurodegeneratif menyebabkan berkurangnya suplai vaskular pada saraf 

(Dam et al., 2013). Kerusakan pada sistem saraf perifer ini yang menjadi pencetus 

luka diabetes karena menyebabkan sensasi nyeri pada kaki berkurang. Faktor lain 

berupa melemahnya respon imun yang ditandai dengan ketidakadekuatan respon 

inflamasi dan suplai darah yang berkurang juga memperburuk penyembuhan luka 

diabetes (Waspadji, 2014). Selain itu, proses penyembukan luka diabetes lebih lama 

daripada luka pada orang normal dikarenakan terganggunya proses penyembuhan 

luka, yang meliputi penurunan pada beberapa hal seperti produksi growth factor, 

respon angiogenik, fungsi makrofag, akumulasi kolagen, fungsi barier epidermal, 

granulasi jaringan, migrasi dan proliferasi keratinosit dan fibroblas, jumlah saraf-

saraf epidermal, bone healing, dan keseimbangan akumulasi komponen ECM 

(extracellular matrix) dan remodeling MMP (matrix methalloproteinase) (Brem et 

al, 2007). 
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Walaupun luka diabetes terlihat seperti luka yang sedang mengalami proses 

penyembuhan, tetapi luka tersebut menjadi tempat berkembangnya infeksi yang 

bisa menyebabkan amputasi jika tidak ditangani (Brem et al, 2007).  Populasi yang 

terdiagnosis diabetes mempunyai resiko 10-20 kali lebih besar mengalami amputasi 

daripada populasi yang nondiabetik (WHO, 2017).  Menurut IDF (2017), setiap 30 

detik di dunia terdapat satu kaki atau bagiannya hilang diamputasi akibat diabetes. 

Di Indonesia, khusunya di RS Ciptomangunkusumo, Jakarta, pada tahun 2008-2012 

terdapat 80 pasien kaki diabetes dengan proporsi reamputasi sebesar 58,7% 

(Sitompul, 2015). Sedangkan dari data Rumah Sakit Luka Nirmala, Jember, pada 

Agustus 2015 hingga Januari 2016 terdapat 34 pasien ulkus diabetes 

(Restuningtyas, 2016). Penanganan bekas luka yang komprehensif diperlukan agar 

luka diabetes tidak semakin buruk menjadi ulser maupun gangren atau hingga bisa 

menyebabkan amputasi (Agustina, 2011; Badr, 2013). 

Penyembuhan luka merupakan proses yang kompleks karena meliputi 

beberapa fase yang terjadi secara simultan. Fase penyembuhan luka dibagi menjadi 

4, yaitu hemostasis, inflamasi, proliferasi dan remodeling jaringan.  Hemostasis 

terjadi ketika terdapat kerusakan pada pembuluh darah, otot polos sirkuler dari 

dinding pembuluh darah akan berkontraksi untuk menghindari lebih banyak darah 

yang keluar, dibantu dengan adanya kaskade pembekuan darah jalur intrinsik, 

ekstrinsik, dan aktivasi platelet. Dilanjutkan dengan fase inflamasi yang terdiri dari 

beberapa mekanisme dengan banyak neutrofil, makrofag, dan limfosit untuk 

mencegah terjadinya infeksi. Kemudian fase proliferasi yang terdiri dari beberapa 

tahap, yakni angiogenesis, migrasi fibroblas, epitelisasi dan retraksi. Fase 

proliferasi ini ditandai dengan adanya sel-sel epitel yang bermigrasi untuk menutup 

luka. Yang terakhir yaitu remodeling jaringan, ditandai dengan tumbuhnya epitel-

epitel normal dan maturasi jaringan parut (Martin, 1997; Harper et al.,2014; 

Okonkwo & DiPietro, 2017).  

Angiogenesis merupakan salah satu tahapan pada fase proliferasi jaringan 

penyembuhan luka. Angiogenesis adalah sebuah proses pembentukan kembali 

kapiler-kapiler darah yang rusak. Proses ini penting untuk oksigenasi dan suplai 

nutrisi pada jaringan yang baru terbentuk (Theoret et al., 2017). Proses awal 
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terjadinya angiogenesis ialah respon adanya hipoksia pada proses hemostasis 

sehingga faktor-faktor proangiogenik seperti vascular endothelial growth factor 

(VEGF) dikeluarkan bersama sitokin-sitokin lain untuk menginduksi migrasi sel-

sel endotel sehingga terjadi pembentukan kapiler-kapiler baru (Harper et al.,2014; 

Okonkwo & DiPietro, 2017). Setelah mencapai puncaknya pada hari ketujuh 

hingga sepuluh, faktor proangiogenik digantikan oleh faktor anti-angiogenik yang 

salah satunya berupa pigment epitellium growth factor (PEGF), sehingga tidak 

terjadi proses angiogenesis yang berlebih (Okonkwo & DiPietro, 2017). Namun, 

pada penyembuhan luka diabetes proses angiogenesis tidak berjalan sempurna. 

Tidak seperti pada nefropati ataupun retinopati diabetik yang mengalami proses 

angiogenesis berlebih, pada penyembuhan luka diabetes proses angiogenesis 

mengalami penurunan. Pada retinopati diabetik angiogenesis meningkat karena 

pericyte yang seharusnya menempel pada kapiler-kapiler pembuluh darah baru 

menghilang, sehingga menyebabkan edema vaskular dan terjadi kebocoran, yang 

menghasilkan neovaskularisasi dan peningkatan VEGF. Di sisi lain, peningkatan 

VEGF terjadi pada diabetik nefropati sehingga menyebabkan peningkatan 

angiogenesis (Okonkwo & DiPietro, 2017). Sedangkan pada luka diabetes, 

penetrasi pembuluh darah baru kurang adekuat sehingga mengakibatkan  

menurunnya sel-sel inflamasi yang masuk ke bagian luka dan menurunkan faktor-

faktor yang dihasilkan oleh sel-sel inflamasi tersebut (Berdal, 2017). Selain itu pada 

orang normal, makrofag beralih fungsi dari fenotip proinflamasi menjadi 

antiinflamasi/proreparasi. Namun pada orang diabetes makrofag gagal 

menstimulasi perbaikan jaringan.  Karema makrofag sendiri sebagai pencetus 

utama munculnya VEGF dan beberapa mediator proangiogenik lain mengalami 

defisit, maka menyebabkan jumlah VEGF-pun juga berkurang dan angiogenesis 

pada luka diabetes mengalami penurunan (Okonkwo & DiPietro, 2017).  

Terapi medikamentosa yang ada untuk menangani luka diabetes yaitu 

antibiotik topikal gentamisin. Namun, obat ini memiliki beberapa efek samping 

berupa iritasi kulit, alergi, kemerahan, hingga bengkak (Prameswari, 2017). Maka 

dari itu, dibutuhkan alternatif lain dalam menangani penyakit ini, salah satunya 

dengan menggunakan umbi bidara upas (Merremia mammosa (Lour.)). Terdapat 
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beberapa kandungan kimia zat aktif dari umbi bidara upas yakni flavonoid, tanin, 

alkaloid, dan resin glikosida (Farizal, 2012; Sofiana et al., 2015). Flavonoid 

mempunyai kegunaan sebagai antiinflamasi dan antioksidan (Hidayat et al., 2015). 

Flavonoid dapat merangsang sel-sel seperti makrofag untuk menghasilkan growth 

factor dan sitokin yang berfungsi untuk proliferasi dan migrasi fibroblas sehingga 

terjadi sintesis kolagen dan keratinosit yang berperan dalam penyembuhan luka 

(Julianto et al., 2015). Selain itu, flavonoid juga bisa sebagai antibakteri karena 

dapat menghambat fungsi DNA girase (Hidayat, 2013). Zat aktif alkaloid juga bisa 

sebagai antibakteri dengan membentuk hambatan kompetitif adhesi protein 

mikroba ke reseptor polisakarida pada inang (Ukhrowi, 2011). Antibakteri lain 

yaitu zat aktif tanin dapat menginaktifasi adhesi sel bakteri, menginaktifkan enzim, 

dan mengganggu protein pada lapisan sel dinding bakteri (Prameswari, 2017). 

Selain itu, terdapat glikosida resin yang mempunyai aktivitas antiinflamasi melalui 

penghambatan selektif COX-1 dan COX-2 (Yoshikawa et al., 2010).  

Berdasarkan penelitian oleh Marchianti et al. (2018), dari beberapa fraksi 

umbi bidara upas (Merremia mammosa (Lour.)) dengan pelarut yang berbeda yaitu 

etil asetat, n-heksana, dan air didapatkan bahwa fraksi air mempunyai hasil 

penyembuhan luka pada tikus diabetes yang paling signifikan. Sehubungan dengan 

hal di atas, maka peneliti ingin mengetahui efektivitas fraksi air umbi bidara upas 

(Merremia mammosa (Lour.)) dalam penyembuhan luka diabetes dengan 

berdasarkan angiogenesis yang dilihat melalui ekspresi vascular endothelial growth 

factor (VEGF).  

 

1.2 Rumusan Masalah 

Berdasarkan latar belakang di atas, maka rumusan masalah dari penelitian 

ini ialah sebagai apakah terdapat perbedaan ekspresi VEGF dari pemberian fraksi 

air umbi bidara upas (Merremia mammosa (Lour.)) dalam berbagai dosis pada 

penyembuhan luka tikus diabetes. 
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1.3 Tujuan Penelitian 

Tujuan umum dari penelitian ini ialah menjelaskan perbedaan ekspresi 

VEGF dari pemberian fraksi air umbi bidara upas (Merremia mammosa (Lour.)) 

dalam berbagai dosis pada penyembuhan luka tikus diabetes. 

 

1.4 Manfaat Penelitian 

Manfaat penelitian ini ialah sebagai berikut. 

 

1.4.1 Manfaat Bagi Ilmu Kedokteran  

a. Sebagai informasi ilmiah efek fraksi air umbi bidara upas (Merremia 

mammosa (Lour.)) pada penyembuhan luka tikus diabetes dilihat melalui 

ekspresi VEGF. 

b. Penambahan ilmu pengetahuan di bidang farmakologi dan histoPA. 

c. Dapat dijadikan sebagai sumber pengembangan penelitian khususnya dalam 

bidang kedokteran. 

 

1.4.2 Manfaat Bagi Pelayanan Kesehatan 

Dapat dijadikan dasar pengembangan tanaman obat di Indonesia baik dalam bidang 

farmasi maupun riset kesehatan untuk menciptakan alternatif baru dalam terapi 

penyembuhan luka diabetes. 

 

1.4.3 Manfaat Bagi Masyarakat 

Masyarakat diharapkan mengetahui manfaat kandungan umbi bidara upas terhadap 

proses penyembuhan luka diabetes.
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BAB 2. TINJAUAN PUSTAKA 

 

2.1 Umbi Bidara Upas (Merremia mammosa (Lour.)) 

2.1.1 Taksonomi dan Morfologi 

 Umbi bidara upas (Merremia mammosa (Lour.)) dalam klasifikasinya 

masuk dalam taksonomi sebagai berikut: 

Kingdom : Plantae 

   Subkingdom : Tracheobionta 

      Superdivisio : Spermatophyta 

         Kelas : Magnoliopsida  

            Sub-kelas : Asteridae 

               Ordo : Solonales  

                  Familia : Convolvulaceae  

                     Genus : Merremia 

                        Spesies : Merremia mammosa (Lour.) Hall.f. 

Sinonim : Battata mammosa Tumph 

      Conculculus mammosa Hall 

      Ipomoea mammosa Chois 

 Nama dagang : Umbi bidara upas 

Nama daerah : Blanar, widoro upas (Jawa), hailale (Maluku/Ambon), bidara upas 

(Sumatera) (Farizal, 2012) 

 Tanaman umbi bidara upas mempunyai ciri-ciri batang melilit, bengkok, 

runcing, bulat dan ramping dengan panjang 3-6 cm. Daunnya tunggal, berseling, 

helai daun tidak berbentuk perisai, pangkal daun berbentuk jantung atau bundar, 

ujung daun runcing, panjang daun berkisar 5-12 cm dan lebar 4-15 cm. Bunganya 

berbentuk lonceng atau payung menggarpu, kelopak bunga 4 helai dan berbentuk 

lonjong, jumlah bunga bisa sampai empat buah, mahkota berwarna putih, dengan 

panjang 7-8 cm. Umbi menyerupai bentuk bulat, lonjong, atau kadang tidak 

beraturan, mirip ubi jalar atau kentang, jika tanah subur bisa menjadi besar hingga 

sebesar buah kelapa atau diameter sekitar 10-30 cm. Umbi bidara upas sering 

dipalsukan dengan umbi Ipomoea digitata, namun bisa dibedakan hanya 
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berdasarkan warna umbi setelah kering yaitu umbi bidara upas kehitaman, 

sedangkan Ipomoea digitata putih. Akarnya bergelantungan dan letak paling atas 

setengah di atas tanah (Kemenkes, 2011; Agil et al., 2013). Morfologi tanaman 

umbi bidara upas dapat dilihat pada Gambar 2.1. 

 

 

 

 

                                              

 

(a) Tanaman bidara upas; (b) Umbi bidara upas 

 

2.1.2 Kandungan dan Kegunaan  

 Kandungan kimia zat aktif dari umbi bidara upas yakni flavonoid, tanin, 

alkaloid, dan resin glikosida (Farizal, 2012; Sofiana et al., 2015). Flavonoid 

mempunyai kegunaan sebagai antiinflamasi dan antioksidan (Hidayat et al., 2015). 

Flavonoid dapat merangsang sel-sel seperti makrofag untuk menghasilkan growth 

factor dan sitokin yang berfungsi untuk proliferasi dan migrasi fibroblas sehingga 

terjadi sintesis kolagen dan keratinosit yang berperan dalam penyembuhan luka 

(Julianto et al., 2015). Selain itu, flavonoid juga bisa sebagai antibakteri karena 

dapat menghambat fungsi DNA girase (Hidayat, 2013). Zat aktif alkaloid juga bisa 

sebagai antibakteri dengan membentuk hambatan kompetitif adhesi protein 

mikroba ke reseptor polisakarida pada inang (Ukhrowi, 2011). Antibakteri lain 

yaitu zat aktif tanin dapat menginaktifasi adhesi sel bakteri dan enzim, serta dapat 

mengganggu protein pada lapisan sel dinding bakteri (Prameswari, 2017). Selain 

itu, terdapat glikosida resin yang mempunyai aktivitas antiinflamasi melalui 

penghambatan selektif COX-1 dan COX-2 (Yoshikawa et al., 2010).  

(a) (b) 

Gambar 2. 1 Bidara upas (Sumber:Kemenkes, 2011; Tokopedia, 2015) 
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Telah banyak penelitian yang dilakukan untuk membuktikan kegunaan zat 

aktif dari umbi bidara upas. Menurut Lubis et al., (2013), ekstrak umbi bidara upas 

(Merremia mammosa (Lour.)) juga bisa menurunkan pertumbuhan bakteri 

Salmonella thypi secara in vitro. Ekstrak etanol umbi bidara upas (Merremia 

mammosa (Lour.)) dengan dosis bertingkat bisa meningkatkan proliferasi limfosit, 

reaction oxygen intermediate (ROI) dan fagositosis makrofag, serta produksi nitrit 

oksida pada tikus dengan infeksi Salmonella typhimurium dibandingkan dengan 

kelompok tanpa pemberian ekstrak umbi bidara upas (Merremia mammosa 

(Lour.)), hal ini berkaitan dengan adanya adanya respon dari senyawa flavonoid di 

dalamnya (Ukhrowi, 2011; Farizal, 2012). Pada fraksi air umbi bidara upas 

(Merremia mammosa (Lour.)) didapatkan adanya senyawa polifenol dan memiliki 

daya hambat terhadap bakteri Mycobacterium tuberculosis (Olevianingrum, 2010). 

Fraksi air umbi bidara upas (Merremia mammosa (Lour.)) paling efektif dalam 

penyembuhan luka diabetes daripada fraksi n-heksana, dan etil asetat (Sakinah et 

al., 2017). Pada fraksi air umbi bidara upas (Merremia mammosa (Lour.)) 

diindikasikan terdapat flavonoid berupa quercentin (Sakinah, 2018).  Tanaman 

umbi bidara upas juga disebutkan dapat mengobati demam, serak, difteri, batuk, 

radang tenggorokan, radang paru, radang usus buntu, muntah darah, kencing manis, 

sembelit, tifoid, keracunan, gigitan ular, sifilis dan kusta (Setyowati, 2003). 

 

2.2 Diabetes Mellitus 

2.2.1 Definisi 

 Diabetes mellitus merupakan suatu penyakit kronik yang diturunkan 

dan/atau diperoleh karena defisiensi produksi insulin oleh pankreas, atau karena 

ketidakefektifan dari produksi insulin (WHO, 2018). Menurut Perkeni (2015), DM 

merupakan suatu kelompok penyakit metabolik dengan karakteristik hiperglikemia 

dikarenakan kelainan sekresi, kerja insulin, atau keduanya. 

 

2.2.2 Klasifikasi  

 Menurut American Diabetes Assosiation (ADA) 2018, diabetes bisa 

diklasifikasikan menjadi empat kategori umum, yaitu:  
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a. Diabetes tipe 1 yaitu karena adanya autoimun yang menyebabkan destruksi sel 

beta, biasanya mengarah pada defisiensi insulin absolut. 

b. Diabetes tipe 2 yaitu karena kehilangan/kerusakan sekresi sel beta secara 

progresif karena adanya resistensi insulin. Selain otot, liver, dan sel beta, organ 

lain seperti jaringan lemak (peningkatan lipolisis), gastrointestinal (defisiensi 

inkretin), sel alfa pankreas (hiperglukagonemia), otak (resistensi insulin), dan 

ginjal (peningkatan absorpsi glukosa) berperan dalam menimbulkan adanya 

gangguan toleransi glukosa pada DM tipe 2 (PERKENI, 2015). 

c. DM gestasional yaitu diabetes yang terdiagnosis pada trimester kedua atau 

ketiga kehamilan dan tidak ada riwayat diabetes sebelum kehamilan. 

d. Diabetes tipe lain karena penyebab lainnya, seperti sindrom monogenic 

diabetes seperti neonatal diabetes, penyakit pada eksokrin pankreas misalnya 

kistik fibrosis dan pankreatitis, serta diabetes yang disebabkan oleh obat atau 

bahan kimia, contohnya karena penggunaan glukokortikosteroid karena 

HIV/AIDS atau setelah transplantasi organ. 

 

2.2.3 Diagnosis  

 Diagnosis DM ditegakkan melalui kriteria glukosa plasma darah, bisa dari 

gula darah plasma saat puasa/fasting plasma glucose (FPG) atau glukosa plasma 2 

jam setelah pemberian 75 gram glukosa oral atau disebut tes toleransi glukosa oral 

(TTGO). Selain itu juga bisa menggunakan kriteria HbA1C (ADA, 2018). Di sisi 

lain terdapat beberapa gejala yang biasa terjadi pada orang DM seperti keluhan 

klasik berupa polyuria, polydipsia, polifagia, dan penurunan berat badan yang tidak 

jelas sebabnya. Keluhan lain seperti lemah badan, kesemutan, gatal, mata kabur 

juga bisa terjadi, serta disfungsi ereksi pada pria dan pruritus vulva pada wanita 

(PERKENI, 2015).  

Berikut merupakan kriteria diagnosis DM menurut PERKENI (2015): 

a. pemeriksaan glukosa plasma puasa ≥126 mg/dl. Puasa yang dimaksud ialah 

kondisi tidak ada asupan kalori minimal 8 jam; atau 

b. pemeriksaan glukosa plasma ≥200 mg/dl pada 2 jam setelah TTGO 75 gram; 

atau 
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c. pemeriksaan glukosa plasma sewaktu ≥200 mg/dl dengan keluhan klasik; atau 

d. pemeriksaan HbA1c ≥6,5% dengan menggunakan metode terstandarisasi oleh 

National Glycohaemoglobin Standarization Program (NGSP). 

Kadar tes untuk diagnosis diabetes dapat dilihat pada Tabel 2.1. 

 
Tabel 2.1 Kadar tes labolatorium darah untuk diagnosis diabetes dan prediabetes 

 

2.3 Penyembuhan Luka Normal dan Diabetes 

2.3.1 Fase Penyembuhan Luka Normal 

 Gangguan pada integritas kulit, permukaan mukosa atau jaringan organ 

akan menghasilkan pembentukan luka (Harper et al., 2014). Luka pada kulit 

menginisiasi sebuah kaskade penyembuhan luka yang nantinya akan 

merekonstruksi area yang terluka. Proses perbaikan luka diawali dengan keluarnya 

beberapa faktor pertumbuhan, sitokin, senyawa molekul-molekul kecil dari bagian 

pembuluh darah yang terluka dan dari platelet yang terdegranulasi (Werner et al., 

2003). Penyembuhan luka merupakan sebuah proses kompleks dari beberapa 

tahapan yang saling tumpeng tindih meliputi inflamasi, pembentukan jaringan 

granulasi, reepitalisasi, pembentukan matriks dan remodeling (Barrientos et al., 

2008).  Untuk lebih jelasnya, berikut merupakan penjelasan pada masing-masing 

fase penyembuhan luka yang dibagi menjadi fase hemostasis, inflamasi, proliferasi 

dan remodeling jaringan (Werner, 2003). 

a. Fase Hemostasis/Koagulasi 

Fase pertama penyembuhan dimulai segera ketika terjadi luka, dan 

selesai dalam beberapa jam sampai terbentuklah hemostasis dan matriks luka 

sementara. Luka pada pembuluh darah dapat menyebakan hemoragik. 

Membran sel endotel mengeluarkan fosfolipid yang berubah menjadi asam 

 HbA1c 

(%) 

Glukosa darah puasa 

(mg/dl) 

Glukosa plasma 2 jam setelah 

TTGO (mg/dl) 

Diabetes ≥6,5 ≥126 ≥200 

Prediabetes 5,7-6,4 100-125 140-199 

Normal <5,7 <100 <140 

Sumber: PERKENI, 2015 
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arakidonat dan metabolitnya yang memediasi tonus dan permeabilitas 

pembuluh darah. Kemudian terjadi vasokontriksi periferal selama 5-10 menit 

untuk membatasi aliran darah yang secara simultan mengurangi suplai oksigen 

dan nutrisi sekitar yang normalnya dibawa oleh darah. Hal ini menyebabkan 

hipoksia sementara dan meningkatkan adanya glikolisis, sehingga pH berubah. 

Perubahan pH berperan dalam menimbulkan aktivasi, adhesi, dan agregasi 

platelet, dengan demikian menginisiasi kaskade koagulasi yang akan 

menghasilkan bekuan darah. Bekuan darah ini membentuk matriks sementara 

yang kaya akan fibrin, fibronektin, vitronektin dan trombospondin, yang 

memenuhi ruang dan sebagai jalan untuk migrasi sel-sel. Selain itu, bekuan 

darah juga berperan sebagai reservoir untuk sitokin dan faktor pertumbuhan 

seperti platelet-derived growth factor (PDGF) dan transforming growth factor 

(TGF)β1 yang dikeluarkan akibat degranulasi platelet (Martin, 1997; Falanga, 

2005; Theoret et al., 2017).  

b. Fase Inflamasi 

Neutrofil dan monosit tertarik ke arah luka karena adanya sinyal 

kemotaktik. Neutrofil sebagai “responden pertama” merupakan sel yang motil 

yang menginfiltrasi dan bermigrasi pada luka dalam 48 jam. Neutrofil 

dimediasi oleh kaskade komplemen, aktivasi interleukin, dan sinyal TGF-β. 

Neutrofil dengan tiga tugas utamanya yaitu fagositosis partikel-partikel asing, 

degranulasi dan mengeluarkan bahan-bahan toksik, serta memproduksi 

kromatin dan protease yang akan membunuh bakteri di ekstraselular. 

Sedangkan adanya makrofrag pada awal fase inflamasi akan memfagositosis 

sisa-sisa organisme patogen, sel-sel lain dan debris matriks, serta 

memperbanyak hormon pertumbuhan dan sitokin ke arah luka, 

mengamplifikasi sinyal luka awal oleh degranulasi platelet dan neutrophil. 

Makrofag pada fase awal inflamasi ini disebut dengan fenotip M1. Kemudian, 

pada akhir fase inflamasi dan memasuki fase proliferasi, makrofag (fenotip 

M2) menstimulasi proliferasi jaringan dermal, endotel, dan epitel untuk 

menyempurnakan pembentukan ECM, angiogenesis dan epitelisasi (Martin, 

1997; Harper et al., 2014; Theoret at al., 2017).  
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c. Fase Proliferasi 

Ketika stimulus telah dikeluarkan, hemostasis sudah tercapai, dan 

respon inflamasi seimbang serta luka telah bebas dari debris, maka fase 

proliferasi mulai untuk memperbaiki defek (Harper et al., 2014). Tujuan dari 

fase ini yaitu memperoleh proteksi pada permukaan luka melalui pembentukan 

granulasi jaringan dan sel-sel epitel baru, serta kembalinya vaskularisasi untuk 

menutrisi jaringan baru (Theoret et al., 2017). Fase ini terdiri dari proses-proses 

kompleks seperti fibroplasia, angiogenesis, epitelisasi dan retraksi luka yang 

terjadi secara simultan (Harper et al., 2014; Theoret at al., 2017) 

1) Fibroplasia  

Selama hari ke-3 hingga ke-5 penyembuhan luka, fibroblas, endotel, 

dan epitel secara cepat membentuk matriks atau pelapis luka. Jaringan 

granulasi terbentuk dari tiga elemen yang secara simultan menuju ke defek 

yaitu makrofag (menghilangkan debris dan memproduksi mediator seperti 

sitokin dan faktor pertumbuhan yang menstimulasi angiogenesis dan 

fibroplasia), fibroblas (proliferasi dan sintesis komponen baru dari ECM), 

dan pembuluh darah baru (pembawa oksigen dam mutrien). Hal ini 

menyebabkan luka berwarna merah dan tampak gambaran granular 

(Theoret et al., 2017). Molekul-molekul matriks seperti sitokin dan faktor 

pertumbuhan menstimulasi fibroblas untuk berproliferasi. Setelah mencapai 

defek luka, fibroblas berproliferasi dan mengubah fungsinya untuk 

mensintesis protein dengan mengubah matriks sementara menjadi matriks 

yang kaya akan koalgen (Theoret et al., 2017). 

2) Angiogenesis 

Angiogenesis penting untuk mengembalikan oksigenasi dan 

menyediakan nutrisi untuk jaringan granulasi yang baru terbentuk. Proses 

awal terjadinya angiogenesis ialah respon adanya hipoksia pada proses 

hemostasis sehingga faktor-faktor proangiogenik seperti vascular 

endothelial growth factor (VEGF) dikeluarkan bersama sitokin-sitokin lain 

untuk menginduksi migrasi sel-sel endotel sehingga terjadi pembentukan 

kapiler-kapiler baru (Harper et al.,2014; Okonkwo & DiPietro, 2017). 
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Untuk stabilisasi pembuluh darah yang baru terbentuk, dibentuklah sel-sel 

otot polos (pericyte) yang diaktifkan oleh adanya platelet derived growth 

factor (PDGF). Setelah mencapai puncaknya pada hari ketujuh hingga 

sepuluh, faktor proangiogenik digantikan oleh faktor anti-angiogenik salah 

satunya berupa pigment epithelium derived factor (PEDF) yang diinduksi 

oleh perycite sehingga tidak terjadi proses angiogenesis yang berlebih 

(Okonkwo & DiPietro, 2017). 

3) Epitelisasi  

Epitelisasi merupakan proses penutupan luka oleh sel-sel epitel 

sehingga luka bisa menutup dengan sempurna. Sel-sel epitel bermigrasi dari 

perifer luka sampai seluruh luka tertutupi. Adanya epithelial-mesenchymal 

transition (EMT) membuat epitel bisa motil/bergerak. Perubahan 

konsentrasi sitokin membuat sel-sel epitel yang motil berubah menjadi 

bersifat proliferatif sehingga bisa menutupi seluruh luka (Theoret et al., 

2017). 

4) Retraksi luka  

  Luka mulai berretraksi sekitar tujuh hari setelah terjadinya luka 

terutama oleh miofibroblas. Interaksi antara aksin dan myosin 

menghasilkan penyempitan dari luas luka. 

d. Fase Remodelling  

Fase ini bisa mencapai 2 tahun dan menghasilkan epitel normal dan 

maturasi jaringan parut. Protein dan kolagen yang terdeposit pada luka menjadi 

semakin teratur dan terjadi penggantian kolagen tipe 1 menjadi tipe 3, sehingga 

jaringan bisa terlihat seperti jaringan tanpa luka (Theoret et al., 2017). Fase-fase 

penyembuhan luka normal ditunjukkan pada Gambar 2.2. 
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Gambar 2.2 Fase-fase penyembuhan luka normal (Sumber: Baltzis et al., 2014) 
 

2.3.2 Gangguan Penyembuhan Luka Diabetes 

 Pada penyembuhan luka normal, proses-proses hemostasis, inflamasi, 

proliferasi dan remodeling jaringan terjadi secara simultan dan overlap. Namun 

perbedaannya, pada penderita diabetes proses-proses ini mengalami penundaan 

atau terhenti di fase yang berbeda. Pada pasien diabetes, proses penyembuhan luka 

dipengaruhi oleh hiperglikemia, inflamasi kronis, disfungsi mikro dan 

makrosirkulasi, hipoksia, neuropati dan gangguan pada sinyal neuropeptida (Baltzis 

et al., 2014). Ringkasan mengenai faktor-faktor yang mempengaruhi penyembuhan 

luka pada pasien diabetes dapat dilihat pada Gambar 2.3.  

Hipoksia dapat memperkuat respon awal inflamasi awal dengan demikian 

dapat memperlama injuri dengan meningkatkan level dari radikal oksigen. 

Hiperglikemia dapat menambah stress oksidatif dengan memproduksi reactive 

oxygen species (ROS). Pembentukan dari advanced glycation-end product (AGEs) 

karena hiperglikemia dan juga interaksi dengan reseptornya mengakibatkan 

terganggunya penyembuhan luka diabetes. Tingginya MMP juga meningkatkan 

aktivitas protease yang menghambat pembentukan penyembuhan luka normal. 
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Beberapa fungsi sel yang terganggu seperti defek pada imunitas sel T (kemotaksis 

leukosit, fagositasis dan kapasitas bakterisidal) serta disfungsi fibroblas dan 

epidermal sel menyebabkan pembersihan bakteri yang inadekuat. Beberapa 

penelitian juga menyebutkan bahwa pada penyembuhan luka diabetes terdapat 

jumlah VEGF sebagai faktor proangiogenik yang menurun dan 

vaskularisasi/angiogenesis juga menurun. Selain itu, neuropati yang terdapat pada 

individu diabetes memperburuk proses penyembuhan luka karena penurunan 

neuropeptida (Guo & DiPietro, 2010). Keseluruhan faktor yang dapat 

mempengaruhi luka diabetes disebutkan pada Gambar 2.4. 

 

 

 

 

 

Gambar 2.3 Pengaruh diabetes pada penyembuhan luka (Sumber: Baltzis et al., 2014) 
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2.3.3 Proses Angiogenesis pada Luka Diabetes 

 Angiogenesis dan vaskulogenesis pada luka diabetes mengalami beberapa 

perubahan dari luka nondiabetes. Sel progenitor endotel menurun pada luka orang 

diabetes dan beresiko mengalami ulser pada kaki. Hiperglikemia dan inflamasi 

kronis merupakan penyebab utama disfungsi dari sel progenitor endotel. Selain itu 

juga disebutkan bahwa terdapat proses glikasi non-enzimatik pada membran dasar 

vaskular, sehingga terjadi gangguan regenerasi pembuluh darah (Baltzis et al., 

2014).  

Angiogenesis mempunyai peran penting dalam patogenesis penyembuhan 

luka diabetes dan penyakit makro dan mikrovaskuler. Angiogenesis bisa meningkat 

maupun menurun tergantung pada proses patogenesis yang terjadi. Tidak seperti 

pada nefropati ataupun retinopati diabetik yang mengalami proses angiogenesis 

berlebih, pada penyembuhan luka diabetes proses angiogenesis mengalami 

penurunan. Pada retinopati diabetik angiogenesis meningkat karena pericyte yang 

seharusnya menempel pada kapiler-kapiler pembuluh darah baru menghilang, 

sehingga menyebabkan edema vaskular dan terjadi kebocoran, sehingga 

menghasilkan neovaskularisasi dan peningkatan VEGF. Di sisi lain, peningkatan 

VEGF terjadi pada diabetik nefropati sehingga menyebabkan peningkatan 

angiogenesis (Okonkwo & DiPietro, 2017). Sedangkan pada luka diabetes sendiri 

penetrasi pembuluh darah baru kurang adekuat yang menyebabkan menurunnya 

sel-sel inflamasi yang masuk ke bagian luka, sehingga menurunkan faktor-faktor 

yang dihasilkan oleh sel-sel inflamasi tersebut (Berdal, 2017). Selain itu pada orang 

normal, makrofag beralih fungsi dari fenotip proinflamasi menjadi 

Gambar 2. 4 Faktor-faktor yang mempengaruhi penyembuhan luka diabetes  

(Sumber: Guo & DiPietro, 2010) 
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antiinflamasi/proreparasi. Namun pada orang diabetes, makrofag gagal 

menstimulasi perbaikan jaringan.  Sedangkan makrofag sendiri sebagai pencetus 

munculnya VEGF dan beberapa mediator proangiogenik lain mengalami defisit, 

sehingga jumlah VEGF-pun juga berkurang dan angiogenesis pada luka diabetes 

mengalami penurunan (Okonkwo & DiPietro, 2017).  

 

2.3.4 Klasifikasi Luka Diabetes 

 Ada banyak klasifikasi luka diabetes yang telah diajukan oleh beberapa 

peneliti, namun klasifikasi yang dijabarkan oleh Wagner Meggit (1970an) ialah 

yang paling lama dan sering dipakai. Klasifikasi ini sering disebut dengan 

klasifikasi Wagner, dengan menggunakan 6 tingkatan luka diabetes pada kaki 

berdasarkan kedalaman dan iskemia (Bowker & Pfeifer, 2007; Jaen & Joshi, 2013). 

a. Klasifikasi kedalaman luka 

1) Tingkat 0: pada kaki yang berisiko, terdapat ulser atau neuropati 

sebelumnya dengan deformitas yang dapat menyebabkan ulserasi baru 

2) Tingkat 1: ulserasi superfisial, tidak terinfeksi 

3) Tingkat 2: ulserasi dalam hingga ke tendon atau sendi (dengan/tanpa 

infeksi superfisial) 

4) Tingkat 3: ulserasi luas hingga ke tulang dan/atau infeksi dalam (seperti 

osteomiolitis atau abses) 

b. Klasifikasi iskemia  

1) Tingkat A: tidak iskemia 

2) Tingkat B: iskemia tanpa gangrene 

3) Tingkat C: parsial (kaki bagian depan atau tumit) 

4) Tingkat D: gangren kaki menyeluruh 

Jika disederhanakan, klasifikasi Wagner dapat dilihat pada Tabel 2.2. 
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Tabel 2.2 Klasifikasi luka diabetes kaki wagner 

Tingkatan Lesi 

Tingkat 0 
Tidak ada lesi terbuka; mungkin terdapat deformitas 

atau selulitis 

Tingkat 1 Ulser superfisial (parsial maupun ful lthickness ) 

Tingkat 2 
Ulser dalam hingga ke ligament, tendon, sendi, atau 

fasia dalam tanpa abses atau osteomiolitis 

Tingkat 3 Ulser dengan abses, osteomilolitis dan sespsis sendi 

Tingkat 4 Gangren kaki depan atau tumit kaki kaki 

Tingkat 5 Gangren seluruh kaki 

(Sumber:Wagner, 1987)  

 

2.3.5 Tatalaksana Luka Diabetes 

 Pentalaksanaan dari ulkus diabetes ialah penutupan luka. Dasar perawatan 

ulkus diabetes yaitu debridement, offloading dan kontrol infeksi (Kruse & Edelman, 

2006). Berikut merupakan penjelasan dari masing-masing tatalaksana.  

a. Debridement 

Debridement merupakan tindakan untuk membuang jaringan nekrosis, kalus 

dan jaringan fibrotik. Metode yang sering digunakan yaitu surgikal, autolitik, 

enzimatik, kimia, mekanis dan biologis (Jones, 2007). 

b. Offloading 

Offloading merupakan pengurangan tekanan pada ulkus. Salah satu metode 

yang digunakan yaitu dengan total contact casting (TCC). TCC dibuat dari gips 

yang dibentuk secara khusus untuk menyebarkan beban pasien keluar dari area 

ulkus (Hariani & Perdanakusuma, 2008). 

c. Kontrol infeksi 

Adanya ulkus memungkinkan masuknya bakteri serta menimbulkan infeksi 

pada luka. Diagnosis infeksi terutama berdasarkan keadaan klinis seperti 

eritem, edema, nyeri, lunak, hangat dan keluar nanah dari luka (Doupis & 

Veves, 2008).  Pada infeksi yang tidak membahayakan biasanya disebabkan 

oleh stafilokokus dan streptokokus, sedangkan pada infeksi berat biasanya 

karena infeksi polimikrobia, seperti streptokokus, stafilokokus, pseudomonas, 
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Enterobacteriaceae dan bakteri anaerob (Stillman, 2008). Dasar utama 

pemilihan antibiotik yaitu berdasarkan kultur sekret dan sensitivitas sel (Langi, 

2011).  

 

2.4 Vascular Endothelial Growth Factor (VEGF)  

 Tanda paling terlihat dalam proses proliferasi yaitu adanya angiogenesis. 

Faktor proangiogenik kemudian diproduksi karena adanya kondisi hipoksia pada 

injuri luka diabetes. Faktor-faktor yang paling penting yaitu vascular endothelial 

growth factor (VEGF). VEGF menstimulasi lekukan dan cabang-cabang immatur 

pembuluh darah baru. Awalnya, hipoksia karena injuri mengaktivasi faktor lain 

berupa hypoxia-inducible factor-1 (HIF-1) yaitu sebuah aktivator transkripsional 

yang akan meningkatkan regulasi dari VEGF-A. VEGF-A, isoform utama pada 

luka, berikatan dengan reseptornya pada sel endotel menyebabkan pertumbuhan 

pembuluh darah. VEGF bersama dengan faktor proangiogenik lain memandu 

pertumbuhan pembuluh darah dari area yang rendah oksigen di daerah perifer 

hingga ke bed luka (Okonkwo & DiPietro, 2017). VEGF tidak hanya diproduksi 

oleh sel-sel endotel, namun juga sel-sel lain seperti fibroblas, sel otot polos, platelet, 

neutrofil, dan makrofag. VEGF mampu menstimulasi komponen pada kaskade 

angiogenik berupa vasodilatasi, degradasi membran dasar, migrasi sel endotel, dan 

proliferasi sel endotel (Bao et al., 2009)  

 

2.5 Model Hewan Coba Diabetes  

Pada awalnya, pembuatan model tikus diabetes yaitu dengan mengambil 

pankreas (pankreatektomi) dari hewan coba anjing. Namun seiring berjalannya 

waktu, model tikus diabetes semakin berkembang.  

 

2.4.1 Model Tikus Diabetes Tipe 1 

 DM tipe 1 merupakan penyakit autoimun dengan multifaktorial berupa 

genetik dan lingkungan yang ditandai dengan destruksi sel beta pankreas oleh sel-

T dan makrofag yang menghasilkan defisiensi insulin yang irreversibel. Model DM 
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tipe 1 dibagi menjadi dua, yaitu tikus spontan diabetes tipe 1 dan dengan pemberian 

agen diabetogenik (Chatzigeorgiou et al, 2009). 

a. Model tikus autoimun spontan DM tipe 1 

Ada beberapa tikus autoimun DM tipe 1, yaitu sebagai berikut. 

1) Tikus Non-obese Diabetic (NOD) 

Insulitis pada tikus NOD diinisiasi pada umur 4-5 minggu, diawali dengan 

limfosit mengelilingi perimeter pulau hingga menginfiltrasi keseluruhan pulau 

pankreas dengan banyak leukosit (terutama CD4+ dan CD8+).  Setelah periode 

subklinis dekstruksi β-sel, ketika diabetes sudah jelas terlihat, ketika 90% dari 

β-sel pankreas sudah rusak (Chatzigeorgiou et al, 2009).  

2) Tikus diabetes-prone BioBreeding (DPBB)  

Tikus DPBB mempunyai karakteristik yang sama dengan tikus NOD, namun 

insulitis terjadi mulai 2-3 minggu sebelum terjadi keadaan klinis dan tidak 

diawali dengan peri-insulitis, selain itu limfosit Th1 predominan pada prosedur 

ini (Chatzigeorgiou et al, 2009). 

3) Tikus Long Evans Tokushima Lean (LETL) 

Tikus model pertama yang secara spontan mengembangkan dekstruksi autoimun 

pada β-sel tanpa mengalami kondisis limfopenia. Tikus Komeda Diabetes-prone 

(KDP) merupakan bentuk model dengan 70-80% bisa menyebabkan diabetes 

pada jantan maupun betina (Chatzigeorgiou et al, 2009). 

4) Tikus LEW.1AR1/Ztm-iddm 

Model tikus baru dengan mekanisme sama dengan tikus BB dan KDP, dengan 

angka diabetes sebesar 70% pada kedua jenis kelamin dan tidak mati tanpa 

pemberian insulin (Chatzigeorgiou et al, 2009).  

b. Tikus dengan pemberian bahan kimia  

Ada beberapa bahan kimia yang digunakan untuk menginduksi DM, yakni sebagai 

berikut. 

1) Streptozotozin (STZ) 

STZ merupakan derivat sintetis nitrosuria glukopiranosa dari 

fermentasi Streptomyces achromogenes (Nugroho, 2006; Etuk, 2010). Bahan 

ini paling sering dipakai sebagai agen diabetogenik. Jenis kelamin yang lebih 
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cenderung bisa mengalami diabetes dengan induksi STZ yaitu tikus jantan, 

karena pada tikus betina lebih resisten terhadap pemberian STZ dosis rendah 

(Wu & Huan, 2008). STZ mencegah reproduksi seluler dengan dosis yang jauh 

lebih kecil daripada dosis yang dibutuhkan untuk menginhibisi koneksi subtrat 

pada DNA atau inhibisi enzim-enzim yang dibutuhkan pada sintesis DNA 

(Holemans & van Anssche, 2003). Administrasi dosis rendah STZ (40 

mg/kgBB) pada tikus membutuhkan waktu 5 hari untuk bisa mencapai diabetes 

yaitu ketika kadar glukosa 180-500 mg/dL (Wu & Huan, 2008; Etuk, 2010).  

Efek toksik STZ pada beta sel pankreas bergantung pada alkilasi DNA 

dari bagian metilnitrosourea. Transfer grup metal dari STZ ke molekul DNA 

menyebabkan kerusakan sehingga menyebabkan fragmentasi DNA. 

Glikosilasi protein juga sebagai faktor tambahan pada kerusakan. Untuk 

memperbaiki DNA tersebut, poli(ADP-ribose) polimerase (PARP) 

ditingkatkan stimulasinya. Hal ini menyebabkan deplesi NAD+ dan 

menurunkan penyimpanan ATP. Penurunan simpanan energi selular 

menyebabkan nekrosis beta sel (Lenzen, 2008).  

2) Alloksan 

Alloksan merupakan bahan kedua terbanyak yang dipakai untuk 

menginduksi DM. Alloksan yaitu derivat urea yang urea yang menyebabkan 

nekrosis selektif pada β-sel pulau pankreas. Alloksan bisa menghasilkan tingkat 

keparahan yang berbeda dengan variasi dosisnya (Etuk, 2010). Toksik alloksan 

pada β-sel menyebabkan oksidasi sulfidril esensial (-SH grup), inhibisi enzim 

glukokinase, meningkatkan radikal bebas dan mengganggu homeostasis dari 

kalsium intraselluler (Rohilla & Ali, 2012).  

3) Ferri nitriloatrisetat 

Bahan ini jarang dipakai karena membutuhkan dosis besar harian dan gejala 

diabetes baru muncul setelah 60 hari. 

c. Genetically induced insulin-dependent diabetes 

Berupa tikus AKITA dengan mutasi spontan pada gen insulin 2 yang mencegah 

proses pro-insulin (King, 2012).  

d. Tikus yang diinjeksi virus 
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Virus yang digunakan untuk menginduksi DM tipe 1 yaitu coxsackie B virus, virus 

ensefalomiokarditis, dan Kilham rat virus (King, 2012).  

e. Model hewan coba non-roden 

Model hewan coba ini menggunakan cara pankreatomi dan induksi STZ. 

Pankreatomi pada babi dan pemberian STZ pada monyet dan babi juga (King, 

2012). 

 

2.4.2 Model Hewan Coba Diabetes Tipe 2 

 Model hewan coba DM tipe 2 ditandai dengan adanya resistensi insulin dan 

tidak adekuatnya beta sel dalam mengompensasi glukosa. Hewan coba DM tipe 2 

sebagian besar merupakan model hewan coba obesitas, karena DM tipe 2 banyak 

dihubungkan dengan kondisi obesitas.  

a. Hewan coba tikus tipe obesitas 

Obesitas bisa secara natural menyebabkan mutasi atau manipulasi genetik. Ada 

beberapa contoh model hewan coba ini, yaitu hewan coba monogenik dan 

poligenik (King, 2012). 

b. Model tikus high fat feeding  

Pemberian makanan lemak bisa menyebabkan obesitas, hiperinsulinemia dan 

terganggunya homeostasis glukosa karena insufisiensi dari kompensasi pulau 

langerhans (Winzell et al., 2004). Banyaknya lemak yang dikonsumsi harus 

dimonitor agar tikus tidak mengompensasi dengan makan lebih sedikit.  

c. Model tikus non-obese 

Tidak semua model hewan coba DM tipe 2 ialah obesitas. Model ini mempunyai 

beta sel yang tidak adekuat, sehingga menyebabkan DM tipe 2 (Weir et al., 2009).  

d. Model hewan coba non-roden 

Hewan coba yang lebih besar juga digunakan dalam penelitian DM. Kucing pernah 

dijadikan sebagai model DM tipe 2 karena ada beberapa hal yang menyerupai DM 

pada manusia, yaitu terjadi pada umur pertengahan, adanya obesitas, resitensi 

insulin, dan beberapa bagian beta sel telak rusak (King, 2012). 
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2.6 Metode Ekstraksi dan Fraksinasi  

 Ekstrak adalah sediaan pekat yang diperoleh dengan mengekstraks zat aktif 

dari simplisia nabati atau hewani menggunakan pelarut yang sesuai, kemudian 

pelarutnya diuapkan dan massa/serbuk yang tersisa diperlakukan sedemikian rupa 

hingga memenuhi baku yang ditetapkan (Ningsih et al., 2016). Sedangkan fraksi 

merupakan pemisahan senyawa lanjutan setelah diekstraksi dengan berdasarkan 

sifat kepolaran pelarut yang dipakai.  

 

2.6.1 Metode Ekstraksi 

 Ekstraksi merupakan proses pemisahan dari bagian aktif tanaman 

menggunakan pelarut dan standar tertentu. Tujuan dari ekstraksi yaitu memisahkan 

metabolit-metabolit tanaman yang terlarut dari residu yang tidak terlarut. Terdapat 

beberapa metode ekstraksi, yaitu maserasi, infusi, perkolasi, dan dekoksi, soxhlet, 

microwave assisted extraction (MAE), ultrasound-assisted extraction (UAE), 

accelerated solvent extraction (ASE), dan supercritical fluid extraction (SFE) 

(Handa et al., 2008; Azwanida, 2015). 

a. Ekstraksi Maserasi, Infusi, Dekoksi dan Perkolasi 

Maserasi dilakukan dengan merendam serbuk simplisia dalam pelarut, 

kemudian didiamkan selama tiga hari pada suhu ruangan. Proses ini bertujuan agar 

cairan pelarut bisa menembus dinding sel tumbuhan, sehingga bisa mengeluarkan 

zat-zat aktif. Infusi dan dekoksi menggunakan prinsip yang sama dengan maserasi, 

namun dengan menggunakan air dingin atau panas. Infusi membutuhkan waktu 

lebih singkat daripada dekoksi, sedangan dekoksi sesuai untuk senyawa yang stabil 

pada suhu tinggi, larut minyak, atau bahan tanaman yang kuat (akar atau kulit). 

Pada perkolasi, simplisia dimasukan pada alat perkolator dengan ditambahkan air 

mendidih dan dimaserasi selama dua jam (Ningsih et al., 2015; Azwanida, 2015) 

b. Ekstraksi Soxhlet 

Ekstraksi ini menggunakan pelarut yang selalu baru dengan alat khusus 

sehingga terjadi ekstraksi berkelanjutan dengan jumlah pelarut yang konstan 

dengan adanya pendingin balik (Ningsih et al., 2016). Nama lain dari ekstraksi ini 

yaitu hot-continuous extraction karena pelarut ekstraksi dipanaskan pada dasar 
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botol labu (flask), kemudian dievaporasi pada thimble, dikondensasi pada 

kondenser, lalu diteteskan kembali. Ketika liquid mencapai siphon arm, kemudian 

dikembalikan lagi pada botol labu (flask) (Azwanida, 2015).  

c. Microwave Assisted Extraction (MAE) 

Radiasi dari microwave pada frekuensi 300 MHz sampai 300GHz dan 

panjang gelombang antara 1 cm dan 1 meter berinteraksi dengan dipol polar dan 

material yang terpolarisasi. Radiasi ini menyebabkan adanya konduksi panas. 

Rotasi dipol pada molekul mengganggu ikatan hidrogen, meningkatkan migrasi 

dari ion yang tidak terlarut dan mendorong adanya penetrasi pada matriks 

(Azwanida, 2015; Altemimi et al., 2017)  

d. Ultrasound-assisted Extraction (UAE) 

UAE menggunakan ultrasound dengan frekuensi 20 kHz hingga 2000 kHz. 

Adanya efek mekanik dari ultrasound menghasilkan peningkatan tumbukan dari 

pelarut dan sampel, sehingga bisa meningkatkan permeabilitas dinding sel sampel 

dan bisa mengeluarkan zat aktif dari sampel. UAE merupakan teknik paling mudah 

dalam pengekstraksian, karena hanya membutuhkan ultrasonic bath dan bisa 

dilakukan pada suhu yang rendah (Handa et al., 2008; Azwanida, 2015; Altemimi 

et al., 2017).  

e. Accelerated Solvent Extraction (ASE) 

ASE merupakan ekstraksi solid-liquid yang dilakukan pada suhu yang 

mengalami peningkatan, biasanya antara 50-200℃ dan tekanan 10-15 MPa. 

Peningkatan suhu mempercepat ekstrasi kinetik dan peningkatan tekanan bisa 

menjaga pelarut dalam bentuk liquid (Handa et al., 2008).  

f. Supercritical Fluid Extraction (SFE) 

Supercritical fluid (SF) atau juga bisa disebut sebagai dense-gas adalah zat 

yang memilihi sifat fisik dari gas dan cairan pada titik kritisnya. Faktor seperti suhu 

dan tekanan merupakan faktor penentu dalam titik kritis ini. Penggunaan CO2 

sebagai pelarut banyak digunakaan pada SFE, dengan titik SF di atas suhu 31,1 ℃ 

dan 7380 kPa. Namun kelemahan dari metode ialah biaya yang sangat mahal 

(Azwanida, 2015).  
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2.6.2 Metode Fraksinasi 

 Fraksinasi merupakan metode pemisahan senyawa lanjutan setelah 

ekstraksi, sehingga terisolasi senyawa berdasarkan kepolaran maupun ukuran 

molekul tertentu. Fraksinasi dapat dilakukan dengan metode ekstraksi cair-cair atau 

kromatografi cair vakum (KCV), kromatografi kolom (KK), size-exclution 

chromatography (SEC), dan solid-phase extraction (SPE). (Sarker et al., 2006; 

Mukhriani, 2014; Prameswari, 2017). Berikut merupakan macam-macam metode 

dari fraksinasi. 

a. Ekstraksi Cair-cair (Kromatografi Cair Vakum (KCV)) 

Ekstraksi cair-cair/liquid-liguid extraction (LLE) adalah teknik 

memisahkan dua liquid/cairan yang bercampur yang digunakan untuk mengisolasi 

komponen-komponen di dalamnya berdasarkan perbedaan permeabilitas (Ahokas 

et al., 2017). Prinsipnya yaitu dengan memisahkan komponen yang tidak larut 

dalam pelarut dengan memindahkan pada pelarut yang lain. 

Pemindahan/transfering ini disebabkan karena adanya perbedaan solubilitas, dan 

ketika semakin besar perbedaannya, semakin besar pula komponen tersebut 

terekstraksi (De Haan & Bosch, 2013). Pelarut yang bertindak sebagai tempat 

pemindahan disebuk “ekstrak dan pelarut”, sedangkan pelarut yang bertindak 

sebagai yang memindahkan disebut raffinate (Ahokas et al., 2017).  

LLE merupakan metode penting dalam pemisahan konstituen/komponen 

pada larutan yang homogen. Pada proses separasi, cairan/liquid kedua yang bersifat 

tidak/sedikit dapat tercampur dengan bahan ekstrak awal (fed material) enyebabkan 

zat terlarut menyebar/terdistribusi.  Kemudian ditambahkan pelarut lagi yang 

bersifat tidak larut/insoluble pada campuran awal, sehingga didapatkan ekstrak dan 

pelarut yang terpisah dari raffinate (Dahal et al., 2016; Ahokas et al., 2017). Prinsip 

kerja pada LLE dapat dilihat pada Gambar 2.5. 
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b. Kromatografi Kolom (KK) 

KK ialah metode yang paling sering digunakan dibandingkan metode 

kromatografi yang lain. Teknik ini digunakan untuk purifikasi biomolekul.  Pada 

KK, fase diam yang digunakan berupa adsorben solid yang diletakkan secara 

vertika; dan fase geraknya berupa liquid (buffer) ditambahkan dari atas kolum. 

Ekstrak kasar yang akan dipurifikasi dimasukkan dari atas kolum.  Liquid ini 

kemudian turun karena gravitasi maupun tekanan udara. Adanya perbedaan 

interaksi komponen-komponen dari ekstrak kasar menyebabkan komponen 

tersebut berhenti pada titik-titik dan waktu tertentu, dengan begitu bisa didapatkan 

senyawa-senyawa yang telah terpisah.. Senyawa yang terpisah tersebut kemudian 

disebut dengan fraksi (Barbara, 2014; Coskun, 2016; Bajpai et al., 2016). 

c. Size-Exclution Chromatography (SEC) 

SEC adalah metode separasi yang berdasarkan ukuran molekul (lebih 

tepatnya, volume hidrodinamik) dari komponen yang dihitung dari seberapa 

efisien molekul tersebut berpenetrasi pada fase diam. SEC dibagi dua macam, yaitu 

yang menggunakan pelarut organik disebut gel permeation chromatography 

(GPC) dan pelarut aquos disebut gel filtration. Molekul dengan berbagai ukuran 

Gambar 2.5 Skema prinsip ekstraksi cair-cari (LLE) (Sumber: De Haan & Bosch, 2013) 
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akan melewati sebuah fase diam yang mempunyai pori-pori dengan ukuran yang 

berbeda-beda. Molekul dengan ukuran lebih besar akan melewati begitu saja pori-

pori dan akan sampai lebih dahulu pada efluen, sedangkan molekul dengan ukuran 

sama atau lebih kecil dari pori-pori akan terdistribusi, dengan sebagian akan masuk 

dalam pori tersebut dan sebagian akan berada di luar pori mengikuti fase gerak, 

sehingga ada sebagian yang sampai efluen namun lebih lambat (Werner et al., 

1994; Vekey et al., 2008; Ismail, 2010) 

d. Solid-Phase Extraction (SPE) 

SPE merupakan metode ekstraksi yang menggunakan fase solid dan liquid 

untuk mengisolasi satu atau lebih analit dari larutan. Biasanya digunakan untuk 

membersihkan sampel sebelum dilakukan kromatografi atau metode analisis lain 

untuk menghitung jumlah analit pada sampel. Prosedur umum dari SPE ialah 

dengan memasukkan larutan pada fase SPE, mencuci komponen yang tidak 

diperlukan dan mengumpulkan analit yang dibutuhkan dengan pelarut lain pada 

sebuah tabung. Fase diam terdapat pada kolum kaca atau plastik di atas frit atau 

benang halus dari kaca (Zwir-Ferenc & Biziuk, 2006).  
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2.7 Kerangka Teori  

Kerangka teori pada penelitian dapat dilihat pada Gambar 2.6 di bawah ini. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Umbi bidara upas (Merremia mammosa (Lour.)) mempunyai beberapa 

kandungan zat aktif yang berfungsi pada penyembuhan luka, yaitu flavonoid 

(sebagai antioksidan, antiinflamasi, dan antibakteri), tanin (sebagai antibakteri), 

alkaloid (sebagai antibakteri) dan resin glikosida (sebagai antiinflamasi). Zat aktif 

ini yang kemudian berperan pada peningkatan penyembuhan luka diabetes 

khususnya pada fase inflamasi. Fase inflamasi yang cepat juga berpengaruh pada 

fase proliferasi, dimana makrofag bisa meningkatkan produksi growth factor 

sebagai faktor angiogenesis yaitu VEGF. VEGF yang meningkat dapat 

Sitokin & 

growth factor 

Proses penyembuhan 

luka diabetes 
Fase Hemostasis 

Fase Inflamasi 

Fraksi air umbi 

bidara upas 

 

Flavonoid 

Tanin 

Antibakteri 

Antiinflamasi 

Antioksidan 

Alkaloid 

Glikosida 

resin 

Makrofag 

Fenotip M1 

(proinflamasi) 

VEGF ↑ 

Angiogenesis ↑ 

Makros: luka mengecil 

Fenotip M2 

(antiinflamasi) 

Fase Proliferasi 

Sintesis fibroblas 

Fase remodeling 

jaringan 

Gambar 2.6 Kerangka teori 

(Yoshikawa et al., 2010; Ukhrowi, 2011; Baltzis et al., 2014;  Hidayat et al., 

2015; Julianto et al., 2015; Prameswari, 2017; Okonkwo & DIPietro, 2017). 
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mempercepat proses angiogenesis, sehingga proliferasi jaringan juga semakin 

meningkat dan pada akhirnya dapat mempercepat proses penutupan luka 

(Yoshikawa et al., 2010; Ukhrowi, 2011; Baltzis et al., 2014;  Hidayat et al., 2015; 

Julianto et al., 2015; Prameswari, 2017; Okonkwo & DIPietro, 2017). 

 

2.8 Kerangka Konsep 

Kerangka konsep pada penelitian ini dapat dilihat pada Gambar 2.7 sebagai berikut. 

 

Gambar 2.7 Kerangka konsep penelitian 

 

Tikus diinduksi dengan STZ agar didapatkan kondisi hiperglikemia. 

Kemudian, dilakukan eksisi luka pada punggung tikus yang kemudian akan diamati 

perubahan luas lukanya. Fraksi air umbi bidara upas (Merremia mammosa (Lour.)) 

merupakan hasil fraksinasi dari ekstrak etanol umbi bidara upas (Merremia 

mammosa (Lour.)). Terdapat beberapa zat aktif pada fraksi air umbi bidara upas 
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yang dapat mempengaruhi penyembuhan luka diabetes, khususnya pada fase 

inflamasi dan proliferasi. Zat aktif tersebut meningkatkan peran dari makrofag 

untuk meningkatkan produksi growth factor, salah satunya berupa faktor 

angiogenesis yaitu VEGF. VEGF yang meningkat dapat mempercepat proses 

angiogenesis, sehingga proliferasi jaringan juga semakin meningkat dan pada 

akhirnya dapat mempercepat proses penutupan luka. 

 

2.10 Hipotesis  

Hipotesis dalam penelitian ini ialah terdapat perbedaan ekspresi VEGF pada 

pemberian fraksi air umbi bidara upas (Merremia mammosa (Lour.)) dalam 

berbagai dosis pada penyembuhan luka tikus diabetes. 
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BAB 3. METODE PENELITIAN 

 

3.1 Jenis Penelitian 

 Jenis penelitian yang digunakan ialah true experimental labolatories karena 

peneliti dengan sengaja memberikan perlakuan kepada subjek penelitian dengan 

tujuan untuk mempelajari efek dari perlakuan tersebut dengan memenuhi 

persyaratan beberapa subjek pada kelompok perlakuan yang sama, adanya 

randomisasi dan kontrol (Irmawati & Nurhaedah, 2017). Penelitian ini 

menggunakan tikus wistar jantan sesuai sebagai sampel dengan kriteria inklusi dan 

eksklusi.  

 

3.2 Rancangan Penelitian 

 Rancangan penelitian ini ialah posttest only control group design yaitu 

dengan membandingkan hasil kelompok perlakuan dengan kelompok kontrol di 

akhir penelitian (Irmawati & Nurhaedah, 2017). Secara sistematis dapat dilihat pada 

Gambar 3.1 di bawah ini. 
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Gambar 3.1 Skema rancangan penelitian 
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Keterangan: 

Po : Populasi tikus wistar jantan di peternakan Malang 

S : Sampel tikus jantan wistar sesuai kriteria inklusi  

A : Adaptasi selama 7 hari 

G : Pemberian STZ untuk induksi diabetes 

R : Randomisasi kelompok dengan proportional stratified random sampling 

menurut BB dan GDA 

K (+) : Kelompok kontrol positif 

K (-) : Kelompok kontrol negatif 

T1 : Kelompok perlakuan 1 (dosis 12,5 mg) 

T2 : Kelompok perlakuan 2 (dosis 25 mg) 

T3 : Kelompok perlakuan 3 (dosis 50 mg) 

T4 : Kelompok perlakuan 4 (dosis 100 mg) 

E : Pemberian luka eksisi ukuran 2x2 cm2  

P : Pemberian salep gentamisin 0,1 % setiap dua hari  

N : Pemberian aquades setiap dua hari sekali  

D1 : Pemberian fraksi air umbi bidara upas dosis 12,5 mg setiap dua hari sekali 

D2 : Pemberian fraksi air umbi bidara upas dosis 25 mg setiap dua hari sekali  

D3 : Pemberian fraksi air umbi bidara upas dosis 50 mg setiap dua hari sekali  

D4 : Pemberian fraksi air umbi bidara upas dosis 100 mg setiap dua hari sekali  

M : Pengambilan jaringan kulit luka untuk dilihat ekspresi VEGF melalui 

pengecatan imunohistokimia 

 

3.3 Tempat dan Waktu Penelitian 

Penelitian dilakukan di beberapa tempat yakni: 

a. Pembuatan fraksi air ekstrak umbi bidara upas di Laboratorium Biologi 

Fakultas Farmasi Universitas Jember 

b. Pemberian perlakuan di Laboratorium Farmakologi Fakultas Kedokteran 

Universitas Jember 

c. Pembuatan preparat imunohistokimia di Laboratorium Patologi Anatomi 

Fakultas Kedokteran Universitas Airlangga 
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d. Pengamatan preparat imunohistokimia dilakukan di Laboratorium Patologi 

Anatomi Fakultas Kedokteran Gigi Universitas Jember 

Waktu pembuatan fraksi dan pemberian perlakuan yaitu pada Juli hingga Agustus 

2017, dilanjutkan pembuatan dan pengamatan preparat pada September hingga 

Desember 2018. 

 

3.4 Populasi dan Sampel Penelitian 

3.4.1 Populasi 

Populasi yang digunakan pada penelitian ini ialah tikus putih jantan galur Wistar 

yang didapatkan dari peternakan di Malang. 

 

3.4.2 Sampel 

Sampel yang digunakan yaitu tikus putih jantan galur Wistar berusia 2-3 bulan 

dengan berat badan 150-220 gram dengan kriteria eksklusi dan inklusi. 

 

3.4.3 Besar Sampel Penelitian 

Penentuan besar sampel pada penelitian yaitu dengan menggunakan 

software Gpower 3.1. Gpower merupakan sebuah software yang digunakan untuk 

menentukan besar jumlah sampel dengan memperhatikan aspek-aspek statistik, 

seperti type 1 error (α), type II error (β), power of analysis (1-β) dan effect size. 

Jumlah kelompok pada penelitian ini terdiri dari 6 dengan jumlah sampel 

perkelompoknya ialah 4, sehingga total jumlah tikus yang digunakan yaitu 24 ekor. 

Sampel dipilih dengan menggunakan kriteria inklusi dan eksklusi sebagai berikut: 

Kriteria inklusi: Kriteria eksklusi: 

1) Tikus jenis wistar 

2) Jenis kelamin jantan 

3) Usia 2-3 bulan 

4) Berat badan 150-220 gram 

5) Tidak ada kelainan anatomis 

1) Mati 

2) Sakit selama masa adaptasi 

ditandai dengan tidak bergerak 

aktif 

3) Terdapat tanda-tanda infeksi 

pada luka yaitu berupa pus pada 

luka  

Digital Repository Universitas JemberDigital Repository Universitas Jember

http://repository.unej.ac.id/
http://repository.unej.ac.id/


34 

 

 

 

 

 Jumlah kelompok sebanyak 6 dan besar sampel 24 memungkinkan 

menghasilkan komponen statistiknya yaitu effect size 0,9 dengan α=0,05 dan power 

of analysis 0,85. Hasil perhitungan besar jumlah sampel dengan menggunakan 

software Gpower terlampir pada Gambar 3.2 sebagai berikut.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.5 Variabel Penelitian 

3.5.1 Variabel Bebas 

 Variabel bebas pada penelitian ini ialah pemberian jumlah dosis fraksi air 

umbi bidara upas (Merremia mammosa (Lour.)).  

 

6) Sehat dan aktif selama masa 

adaptasi 

7) Kadar glukosa ≥200 mg/dL  

 

Gambar 3.2 Komponen statistik penelitian 
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3.5.2 Variabel Terikat 

 Variabel terikat pada penelitian ini ialah ekspresi VEGF yang terlihat 

dengan pewarnaan imunohistokimia pada luka tikus diabetes. 

3.5.3 Variabel Kontrol 

 Variabel kontrol pada penelitian ini ialah kadar glukosa darah dan berat 

badan tikus. 

 

3.6 Definisi Operasional 

Definisi operasional dijelaskan melalui Tabel 3.1. 

 

Tabel 3.1 Definisi operasional 

Variabel Definisi Operasional Hasil Ukur Alat Ukur 
Skala 

Data 

1. Fraksi air 

umbi 

bidara 

upas 

Hasil fraksinasi berupa lapisan air dari 

ekstrak etanol umbi bidara upas (Merremia 

mammosa (Lour.)) yang dibuat di 

Laboratorium Biologi Fakultas Farmasi 

Universitas Jember dan diberikan secara 

topikal pada luka tikus diabetes. Dosis yang 

digunakan pada penelitian ini ialah 12,5 mg, 

25 mg, 50 mg, dan 100 mg mengacu pada 

penelitian Marchianti (2018) yang diberikan 

pada kelompok perlakuan secara topikal 

setiap dua hari sekali, yaitu pada hari ke-15, 

17, 19, 21, dan 23 atau dalam kurun waktu 10 

hari post-eksisi (Prameswari, 2017; 

Marchianti et al,, 2018). 

 

- - - 

2. Luka tikus 

diabetes 

Luka eksisi hingga ke lapisan subkutan pada 

tikus yang telah diinduksi STZ dengan 

ukuran 2x2 cm2. Pemberian luka yaitu 

dengan mencukur bulu tikus bagian 

punggung kiri tikus, kemudian ditandai 

dengan stempel ukuran 2x2 cm2, selanjutnya 

dilakukan eksisi sesuai garis dari stempel 

tersebut (Prameswari, 2017).  

- - - 
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3. Ekspresi 

VEGF 

Presentasae dan intensitas area pembuluh 

darah yang terpulas coklat dari luka tikus 

diabetes pada pengecatan spesifik 

imunohistokimia dengan antibodi VEGF 

yang kemudian diukur dengan skor histologi 

untuk imunohistokimia (Setiabudi, 2005; 

Maae et al., 2011; Chung et al., 2014).  

Skor angka 

tanpa 

satuan 

Mikroskop, 

optilab, 

dan 

software 

ImageJ 

Rasio 

4. Kadar 

glukosa 

darah 

Kadar glukosa darah hiperglikemia jika 

melebihi 200 mg/dL pada hari kelima setelah 

pemberian STZ. Kadar gula darah diukur 

pada hari ke-13 dan 24 (Marchianti et al, 

2018; Sakinah et al., 2018).  

Kadar 

glukosa 

darah 

(mg/dL) 

a) Positif 

DM ( 

≥200 

mg/dL) 

b) Negatif 

DM ( 

<200 

mg/dL) 

Glucotest Interval 

 

3.7 Alat dan Bahan Penelitian 

3.7.1 Alat 

 Alat-alat yang digunakan pada penelitian ini ialah sebagai berikut: 

a. Alat untuk pembuatan fraksi air umbi bidara upas, yaitu ayakan, blender, beker 

glass, timbangan, corong Buncher, rotator, evaporator, maserator, freeze dryer, 

handscoon dan pengaduk 

b. Alat untuk pemeliharaan, yaitu bak plastik, alas jaring-jaring dari kawat, 

penutup kawat dan berlapis kasa, tempat makan, tempat minum, label, dan 

sekop kecil 

c. Alat untuk menginduksi STZ, yaitu pengaduk, beaker glass, spuit, neraca 

ohaus, dan handscoon  

d. Alat untuk pembuatan dan pemberian dektrosa 10%, yaitu erlenmeyer/tabung 

dan tempat minum 

e. Alat untuk pemberian fraksi, yaitu aluminium foil, neraca ohaus, spatula, dan 

handscoon 
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f. Alat untuk mengukur berat badan, yaitu timbangan kasar dan wadah untuk 

meletakkan tikus 

g. Alat untuk mengukur kadar glukosa darah, yaitu stik glukosa, glucotest dan 

gunting bedah 

h. Alat untuk membuat luka, yaitu pisau bedah, stempel cetakan luka 2x2 cm2, 

spuit dan handscoon 

i. Alat untuk mengukur luka, yaitu kertas kalkir/transparan, spidol, dan gunting 

j. Alat untuk pengambilan jaringan kulit, yaitu alat bedah, tempat fiksasi, 

handscoon dan tube 

k. Alat untuk pembacaan pewarnaan imunohistokimia, yaitu kamera, mikroskop, 

laptop/computer, dan software ImageJ. 

 

3.7.2 Bahan Penelitian 

Bahan penelitian ini ialah sebagai berikut. 

a. Bahan untuk pembuatan fraksi air umbi bidara upas, yaitu simplisia umbi 

bidara upas 

b. Bahan untuk pemeriksaan glukosa darah, darah yang diambil dari ekor mencit 

c. Bahan untuk pemeliharaan tikus, yaitu pakan tikus, air, dan sekam kering 

d. Bahan untuk pemberian STZ, yaitu buffer sitrat dan STZ 

e. Bahan untuk pembuatan dekstrosa 10%, bubuk dekstrosa 10 gram dan air 100 

ml untuk masing-masing tikus 

f. Bahan untuk pembuatan luka eksisi, yaitu ketamin dan xylazine 

g. Bahan untuk pengambilan jaringan kulit, yaitu formalin 

h. Bahan untuk pembuatan preparat imunohistokimia, yaitu IHC kit dan antibodi 

VEGF. 

 

3.8 Prosedur Penelitian 

3.8.1 Pemilihan Hewan Coba 

 Hewan coba dipilih sesuai kriteria inklusi dan eksklusi yang tertera pada 

subbab 3.3.  
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3.8.2 Adaptasi Hewan Coba 

 Adaptasi hewan coba dilakukan dengan menempatkan tikus pada bak 

plastik, dengan ditambahkan sekam yang di atasnya terdapat jaring-jaring kawat 

dan bagian atas bak digunakan penutup berupa jaring-jaring kawat dan dilapisi 

kasa. 

 

3.8.3 Pembagian Kelompok Perlakuan 

Kelompok perlakuan dibagi menjadi 6, yaitu sebagai berikut. 

 

Tabel 3. 2 Pembagian kelompok perlakuan 

Nama Kelompok Pemberian Perlakuan 

Kontrol positif (K(+)) pemberian salep gentamicin 0,1% 

Kontrol positif (K(-)) pemberian aquadest secara topikal 

Kelompok 1 (T1) 
pemberian fraksi air umbi bidara upas dosis 12,5 mg 

secara topikal 

Kelompok 2 (T2) 
pemberian fraksi air umbi bidara upas dosis 25 mg 

secara topikal 

Kelompok 3 (T3)  
pemberian fraksi air umbi bidara upas dosis 50 mg 

secara topikal 

Kelompok 4 (T4) 
pemberian fraksi air umbi bidara upas dosis 100 mg 

secara topikal 

 

3.8.4 Pembuatan Ekstrak 

 Berikut ini merupakan proses pembuatan ekstrak umbi bidara upas. 

a. Umbi bidara upas yang telah tua dipotong-potong, kemudian dikeringkan 

dengan diangin-anginkan atau dioven pada suhu 60℃.  

b. Umbi bidara upas yang telah kering dihaluskan dengan blender. 

c. Serbuk umbi bidara upas sebanyak 1 kg diekstraksi dengan ultrasonic 

menggunakan pelarut etanol 70% sebanyak 5 liter selama satu jam dengan 

sesekali diaduk.  

d. Ekstrak yang dihasilkan disaring dengan corong buchner sehingga diperoleh 

filtrat. Residu yang tersisa dimaserasi ulang dengan ultrasonic hingga tiga kali. 
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e. Filtrat yang sudah terkumpul dipekatkan dengan rotary evaporator hingga 

didapatkan ekstrak etanol. Ekstrak yang diperoleh dikentalkan dengan 

penguapan di atas waterbath  sehingga didapatkan ektrak etanol kental. 

Prosedur tetap ekstraksi dari Labolatorium Biologi Fakultas Farmasi Universitas 

Jember dapat dilihat pada Lampiran 3.1. 

 

3.8.5 Pembuatan Fraksi Air Umbi Bidara Upas 

 Proses pembuatan fraksi air umbi bidara upas diuraikan sebagai berikut. 

a. Ekstrak etanol kental yang sudah didapatkan kemudian dilakukan fraksinasi. 

Sebanyak 120 gram ekstrak ditambah dengan 240 mL akuades dan diaduk 

hingga tercampur, kemudian dimasukkan ke corong pisah.  

b. Ditambahkan n-heksana sebanyak 360 mL pada campuran ekstrak dan air, 

kemudian dikocok kuat selama 2-5 menit dan didiamkan hingga didapatkan 

lapisan n-heksana dan air. Lapisan n-heksana (bagian atas)  diambil melalui 

lubang atas, sedangkan lapisan air dikeluarkan melalui kran bawah. Tahapan ini 

diulang hingga 2 kali. 

c. Sisa lapisan air diukur volumenya, kemudian dimasukkan ke dalam corong 

pisah, kemudian ditambahkan etil asetat dengan perbandingan 1:3.  

d. Campuran dikocok selama 2-5 menit dan didiamkan sampai lapisan etil asetat 

dan air terpisah sempurna. Lapisan etil asetat di bagian atas diambil melalui 

lubang atas setelah lapisan air dikleurkan melalui kran bawah. Tahapan ini 

diulang 2 kali.  

e. Lapisan air dipekatkan dengan freeze drying setelah dipisahkan dari residu 

ekstrak etanol yang tidak larut air. 

f. Hasil fraksi air umbi bidara upas dari proses freeze drying dikumpulkan untuk 

penelitian.  

Prosedur tetap fraksinasi dari Labolatorium Biologi Fakultas Farmasi Universitas 

Jember dapat dilihat pada Lampiran 3.1. 
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3.8.6 Penginduksian Streptozotocin (STZ) 

 Induksi STZ dilakukan intraperitoneal dengan dosis STZ 40 mg/kgBB yang 

dilarutkan dalam buffer sitrat 0,05 mol/L pada hari ke-8 (Marchianti et al., 2018; 

Sakinah et al., 2018; Damasceno et al., 2014; Badr, 2013) 

 

3.8.7 Pemeriksaan Kadar Glukosa  

 Pemeriksaan kadar glukosa dilakukan dengan memotong ±0,5 cm ujung 

ekor tikus dengan gunting, kemudian darah dimasukkan pada stik glukosa, dan 

dicek pada glucose meter (Easytouch). Dikatakan hiperglikemia apabila kadar 

glukosa darah melebihi 200 mg/dL. Pemeriksaan dilakukan pada hari ke 13 dan 24 

(Mustaghfiroh & Probosari., 2014; Marchianti et al., 2018). 

 

3.8.8 Pemberian Luka Eksisi 

 Pemberian luka eksisi dilakukan pada hari ke-14 didahului dengan 

pemberian xylazine 10 ml/kgBB dan ketamin 80 mg/kgBB secara intramuskular 

(Yudaniayanti et al., 2010). Ketika anastesinya bekerja, kulit tikus dicukur, 

kemudian daerah dorsal sinistra tubuh tikus yang akan dieksisi distempel dengan 

ukuran 2x2 cm2 untuk memfiksasi bagian yang akan dieksisi. Kemudian, dilakukan 

eksisi menggunakan pisau bedah sesuai garis bekas stempel yaitu berukuran 2x2 

cm2 (Montandon et al., 1977; Dorsett-Martin, 2004; Prameswari, 2017; Sakinah et 

al., 2018). 

 

3.8.9 Pemberian Fraksi Air Ekstrak Umbi Bidara Upas  

 Fraksi air dengan dosis 12,5 mg pada kelompok T1, 25 mg pada T2, 50 mg 

pada T3, dan 100 mg pada T4 diberikan setiap 2 hari sekali, yaitu pada hari ke-15, 

17, 19, 21, dan 23 terhitung dari awal adaptasi (Marchianti et al., 2018). 

 

3.8.10 Pengambilan Jaringan Kulit 

 Pengambilan jaringan kulit dilakukan pada hari ke-24. Sebelum diambil 

jaringannya, tikus diterminasi dengan anastesi perinhalasi menggunakan 

kloroform. Kemudian diambil jaringan kulit yang luka dan disimpan dalam botol 
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jaringan yang sudah berisi formalin 10% dan kemudian dilakukan dislokasi servikal 

(Prameswari, 2017). 

 

3.8.11 Pembuatan Preparat Imunohistokimia 

 Pembuatan preparat imunohistokimia dilakukan di Labolatorium Patologi 

Anatomi Fakultas Kedokteran Universitas Airlangga. Pewarnaan menggunakan kit 

imunohistokimia dengan antibodi poliklonal VEGFB167 bs-10071R dari 

BIOSSUSA. Prosedur pembuatan preparat imunohistokimia ialah sebagai berikut. 

a. Deparafinisasi dengan menggunakan Xylol 1, Xylol 2, dan Xylol 3 masing-

masing 5 menit 

b. Rehidrasi dengan alkohol bertingkat dari alkohol absolut, alkohol 96%, alkohol 

80%, dan alkohol 70%, masing-masing 4 menit 

c. Cuci dengan air mengalir selama 5 menit 

d. Blocking dengan menggunakan endogen peroksidase 0,5% selama 30 menit 

e. Cuci kembali dengan air mengalir selama 5 menit 

f. Decloaking Chamber 110℃ selama 30 menit dengan larutan Diva 

g. Kemudian didinginkan ±30 menit  

h. Cuci dalam PBS (Phosphate-buffered saline)  pH 7,4 selama 3 menit 

i. Blocking dengan Normal Horse Serum 5% selama 30 menit 

j. Pemberian antibodi primer poliklonal VEGFB167 bs-10071R dari BIOSSUSA  

selama 60 menit 

k. Cuci dalam PBS (Phosphate-buffered saline)  pH 7,4 selama 3 menit 

l. Universal link selama 30 menit  

m. Cuci dalam PBS (Phosphate-buffered saline)  pH 7,4 selama 3 menit 

n. Labelling dengan menggunakan trekavidin HRP selama 30 menit 

o. Cuci dalam PBS (Phosphate-buffered saline)  pH 7,4 selama 3 menit 

p. Pemberian DAB dan substrat buffer selama 2-5 menit 

q. Cuci dengan air mengalir selama 5 menit 

r. Lakukan counterstaining dengan pewarnaan Haematoxylin (HE) selama 5-10 

menit 
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s. Dehidrasi dengan alkohol bertingkat yaitu alkohol 80%, 90%, dan absolut, 

masing-masing selama 5 menit 

t. Clearing dengan menggunakan Xylol 1, Xylol 2, dan Xylol 3, masing-masing 

selama 5 menit 

u. Mounting dengan cover glass 

Prosedur tetap pengecatan imunohistokimia Labolatorium Patologi Anatomi 

Fakultas Kedokteran Universitas Airlangga dapat dilihat pada Lampiran 3.2. 

 

3.8.12 Pengamatan Ekspresi VEGF 

 Ekspresi VEGF dihitung dari persentase dan intensitas warna pembuluh 

darah yang terpulas coklat pada 5 lapang pandang dengan menggunakan mikroskop 

Olympus CX21 LED perbesaran 400 kali, kemudian gambar dianalisis 

menggunakan software ImageJ yang langkah-langkahnya dapat dilihat pada 

Lampiran 3.3 (Setiabudi, 2005; Destri et al., 2017; Chen et al., 2014; Rosyidah et 

al., 2018). Perhitungan ekspresi VEGF menggunakan skor histologi yaitu sebagai 

berikut (Setiabudi, 2005; Chung et al., 2014): 

Skor = (IK × PK) + (IS×PS) + (IL×PL) 

Keterangan: 

 P : persentase 

 I : intensitas 

 K : kuat 

 S : sedang 

 L : lemah 

Intensitas warna dapat diketahui sebagai nilai kuantitatif dan dapat dinilai sebagai 

berikut (Maae et al., 2011): 

1 : intensitas lemah 

2 : intensitas sedang 

3 : intensitas kuat 

Hasil skoring dari perhitungan 5 lapang pandang kemudian dirata-rata 
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3.9 Analisis Data Penelitian 

Analisis data menggunakan program software statistik. Jika data normal dan 

homogen, maka dilanjutkan dengan uji parametrik komparasi uji One Way Anova, 

dilanjutkan uji Post Hoc Fisher’s LSD (Least Significant Difference). Namun, jika 

data tidak normal, dilakukan uji non-parametrik Kruskal Wallis dan dilanjutkan uji 

Post Hoc Mann-Whitney.  

 

3.10 Alur Penelitian 

Alur penelitian ini dibagi dalam beberapa tahapan yakni sebagai berikut. 

3.10.1 Tahapan Pembuatan Ekstrak Umbi Bidara Upas 
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10 Kg Umbi 

Bidara Upas 

Dikeringkan 

Diblender 

1 kg simplisia 

Diekstraksi dengan ultrasound dengan 

pelarut etanol 70% sebanyak 5 L 

Disaring dengan corong Buchner 

Filtrat 

Diuapkan dengan rotary evaporator 

Ekstrak kental 

Residu 

Gambar 3.3 Skema pembuatan ekstrak umbi bidara upas 
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3.10.2 Tahapan Pembuatan Fraksi Air Umbi Bidara Upas 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.10.3 Prosedur Pembuatan Preparat Imunohistokimia 

Prosedur pembuatan preparat imunohistokimia dijabarkan pada Lampiran 3.1. 

 

120 gram ekstrak kental 

Ditambahkan 240 aquades, diaduk hingga homogen 

Ditambahkan 360 mL n-heksana 

Dimasukkan ke corong pisah, dikocok 2-5 menit dan didiamkan 

Lapisan air 

Ditambahakan 360 mL etil asetat 

Lapisan n-heksana 

Freze drying 

Fraksi air 

Dimasukkan ke corong pisah, dikocok 2-5 menit dan didiamkan 

Lapisan air Lapisan etil asetat 

2x 

pengulangan 

2x 

pengulangan 

 

Gambar 3.4 Skema pembuatan fraksi air umbi bidara upas 
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3.10.4 Langkah Penggunaan Software ImageJ dalam Perhitungan Ekspresi VEGF 

 

  

Buka Software ImageJ 

Klik Open → buka file gambar → pilih gambar 

Klik Plugin → IHC Tool Box → Pilih H-DAB → Klik Color 

Ubah gambar menjadi 8-bit dengan Klik Image → Type → 8-bit 

Tandai gambar dengan Threshold, dengan Klik Image → Adjust 

→ Threshold → atur warna sesuai gambar 

Klik Measure → catat hasil 

 

Hitung ekspresi VEGF dengan menghitung luas, dengan Klik 

Analyze → Set Measurement → pilih Limit to Threshold → 

Recirect to: Stain Color Detection → Klik OK 

Gambar 3.5 Skema perhitungan ekspresi VEGF dengan software ImageJ 

Digital Repository Universitas JemberDigital Repository Universitas Jember

http://repository.unej.ac.id/
http://repository.unej.ac.id/


46 

 

 

 

 

3.10.5 Tahapan Perlakuan pada Hewan Coba 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Pengambilan 24 tikus wistar jantan dan 

pembagian kelompok 

Adaptasi 

Induksi STZ 

Pemeriksaan glukosa dan BB 

Pemberian luka eksisi 

 

 

 
 

 

Pemberian perlakuan 

Fraksi air  

100 mg 

Fraksi air  

50 mg 

 

Fraksi air  

12,5 mg 

 
Fraksi air  

25 mg 

Gentamisin 

1% 

 
Aquadest 

 

Pemeriksaan glukosa dan BB 

Pengambilan jaringan kulit 

Pembuatan preparat imunohistokimia 

Pengamatan ekspresi VEGF 

Analisis statistika 

Hari 0 

Hari 1-7 

Hari 8 

Hari 13 

Hari 14 

Hari 15, 

17, 19, 

21, dan 

23 

 

Hari 24 

Hari 24 

Gambar 3.6 Gambar tahapan perlakuan dan prosedur lain 
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3.11 Uji Kelayakan Etik 

 Subjek yang digunakan dalam penelitian ini ialah tikus putih wistar dengan 

jenis kelamin jantan yang harus mendapatkan sertifikat kelayakan etik dari komisi 

etik kedokteran. Sehingga diharapkan akan menjamin keamanan bagi hewan coba 

maupun peneliti, melindungi hewan coba, dan memperjelas tujuan serta kewajiban 

peneliti. Surat keterangan kelayakan etik dapat dilihat pada Lampiran 3.4. 
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 BAB 5. PENUTUP 

 

5.1 Kesimpulan 

 Berdasarkan hasil penelitian yang diperoleh, maka dapat disimpulkan 

bahwa terdapat perbedaan yang signifikan dari ekspresi VEGF dengan pemberian 

fraksi air umbi bidara upas (Merremia mammosa (Lour.))  pada penyembuhan luka 

tikus diabetes.  

 

5.2 Saran 

 Dari hasil penelitian di atas, perlu dilakukan penelitian lanjutan mengenai 

pertimbangan bahan pembawa (vehicle) sebagai campuran dalam pemberian fraksi 

air umbi bidara upas agar didapatkan efek terapi yang lebih optimal. Pada penelitian 

selanjutnya dapat digunakan perlakuan pemberian terapi pada kontrol positif yang 

lebih sesuai untuk peningkatan VEGF seperti becaplermin atau bioplacenton, dan 

bisa juga diteliti sampai sejauh mana dosis fraksi air umbi bidara upas dapat 

mempengaruhi peningkatan ekspresi VEGF dan efektif dalam penyembuhan luka 

tikus diabetes. Di sisi klinisnya, penelitian ini memakai teknik perawatan luka 

terbuka yang mungkin untuk penelitian selanjutnya dapat dilakukan perawatan luka 

tertutup sehingga lebih menyerupai perawatan pada manusia.  
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LAMPIRAN 

 

Lampiran 3.1 Prosedur ekstraksi dan fraksinasi 
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Deparafinisasi sebanyak 3 kali (Xylol 1, Xylol 2, Xylol 3) 

Rehidrasi bertingkat (Alkohol absolut, 96%, 80% dan 70%) 

Cuci dengan air mengalir 

Decloaking chamber dengan larutan Diva dalam suhu 110℃ selama 30 menit 

Didinginkan selama ±30 menit 

Blocking dengan Normal Horse Serum 5% 

Pemberian antibodi primer poliklonal VEGFB167 bs-10071R dari BIOSSUSA 

Cuci dengan PBS (Phosphate-buffered saline) pH 7,4 

Universal link selama 30 menit 

Cuci dengan PBS (Phosphate-buffered saline) pH 7,4 

Labelling dengan treakavidin HRP  

Blocking dengan Endogen Peroksidase 0,5% 

Cuci dengan air mengalir 

Lampiran 3. 2 Prosedur Pengecatan Imunohistokimia 
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Cuci dengan air mengalir 

Counterstaining dengan Hematoxylin (HE) 

Dehidrasi dengan alkohol bertingkat (Alkohol 80%, 96% dan alkohol asolut) 

Clearing dengan Xylol 1, Xylol 2, dan Xylol 3 

Mounting dengan cover glass 

Cuci dengan PBS (Phosphate-buffered saline) pH 7,4 

Staining dengan DAB dan pemberian substrat buffer 
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Lampiran 3.3 Langkah Perhitungan Ekspresi VEGF 

1. Buka software ImageJ 

 

2. Pilih gambar yang akan dianalisis dengan klik File → Open atau drag/seret 

gambar pada software ImageJ hingga gambar muncul pada layar 
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3. Pilih IHC toolbox pada menu Plugin. Pilih Select Model → H-DAB, kemudian 

pilih color. 

 

Kemudian akan muncul gambar seperti ini.  

 

 

 

 

 

 

 

Digital Repository Universitas JemberDigital Repository Universitas Jember

http://repository.unej.ac.id/
http://repository.unej.ac.id/


80 

 

 

 

 

4. Pilih menu image → type → 8 bit. Kemudian gambar akan berubah menjadi 

warna monokrom. 

 

5. Pilih menu Image → Adjust → Threshold atau bisa langsung menggunakan 

Ctrl+Shift+T. Kemudian akan muncul menu Threshold dan gambar akan berubah 

warna. Atur threshold dengan menggerakkan garis sesuai intensitas yang 

diinginkan. Jika ingin mengetahui intensitas lemah, maka geser garis bagian atas ke 

arah kanan, jika ingin mengetahui intensitas kuat geser garis bagian bawah ke arah 

kiri. Kemudian klik Apply. 
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6. Setelah itu, pilih menu Analyze → Set measurements. Tandai Area, Area 

fraction dan Limit to threshold. Pilih Redirect to: Stain Color Detection. 

 

 

 

 

 

Digital Repository Universitas JemberDigital Repository Universitas Jember

http://repository.unej.ac.id/
http://repository.unej.ac.id/


82 

 

 

 

 

7. Pilih menu Analyze → Measure atau bisa langsung dengan Ctrl+M, hingga 

muncul hasil. 
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Lampiran 3. 4 Surat Keterangan Persetujuan Etik 
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Lampiran 4.1 Hasil Ekstraksi dan Fraksinasi 
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Lampiran 4.2 Dokumentasi luka secara makroskopis  

a. Dokumentasi hari ke-3 post-eksisi 

 
Kontrol negatif 

 

 
Kontrol positif 

 

 
Kelompok T1 

 

 
Kelompok T2 

 
Kelompok T3 

 
Kelompok T4 

b. Dokumentasi hari ke-5 post-eksisi 

 

Kelompok K(-) 

 

Kelompok K(+) 
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Kelompok T1 

 

 
Kelompok T2 

 
Kelompok T3 

 

 
Kelompok T4 

c. Dokumentasi hari ke-7 post-eksisi 

 
Kelompok K(-) 

 

 
Kelompok K(+) 

 
Kelompok T1 

 

 
Kelompok T2 

 
Kelompok T3 

 
Kelompok T4 
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d. Dokumentasi hari ke-9 post-eksisi 

 

 
Kontrol negatif 

 
Kontrol positif 

 

 
Kelompok T1 

 

 

 
Kelompok T2 

 

 
Kelompok T3 

 
Kelompok T4 
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Lampiran 4.3 Data Perhitungan Ekspresi VEGF 

a. Ekspresi VEGF dalam persentase dengan intensitas masing-masing 

Nama 

Kelompok 

Lapang 

Pandang 

Luas Area Ekspresi VEGF 

Lemah Sedang Kuat Total 

K+1 1 11.21 14.88 16.08 42.16 

2 18.61 9.98 13.51 42.10 

3 15.28 6.16 14.72 36.17 

4 15.33 9.93 16.44 41.69 

5 15.17 11.41 15.22 41.80 

K+2 1 25.71 6.65 1.08 33.44 

2 25.68 5.78 2.46 33.92 

3 27.73 2.19 2.15 32.08 

4 30.39 2.50 2.09 34.98 

5 24.84 4.49 3.45 32.79 

K+3 1 12.04 3.29 17.50 32.82 

2 10.18 2.07 11.60 23.85 

3 16.01 3.52 4.85 24.38 

4 7.17 5.38 8.08 20.64 

5 12.22 3.72 7.79 23.74 

K+4 1 10.29 4.73 18.58 33.61 

2 10.43 4.53 22.54 37.50 

3 12.08 8.84 12.89 33.81 

4 14.53 0.44 20.36 35.33 

5 12.26 10.21 12.96 35.43 

K-1 1 9.41 5.80 9.66 24.87 

2 8.17 8.00 8.65 24.82 

3 12.42 8.46 11.47 32.35 

4 12.59 6.58 8.33 27.50 

5 25.54 3.04 0.42 29.00 

K-2 1 9.90 2.64 6.68 19.22 

2 11.40 2.72 8.71 22.84 

3 10.04 5.59 7.66 23.29 

4 9.78 3.49 8.63 21.90 

5 7.66 5.46 13.35 26.47 

K-3 1 10.49 13.35 8.58 32.42 

2 11.35 4.15 9.78 25.28 

3 9.36 6.38 10.69 26.43 

4 11.29 4.22 5.34 20.85 

5 8.48 5.34 5.68 19.49 

K-4 1 17.42 5.84 4.01 27.26 
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2 7.65 5.22 2.52 15.39 

3 8.46 6.87 0.02 15.35 

4 14.11 0.34 5.51 19.96 

5 9.52 2.12 4.51 16.14 

T1.1 1 11.612 7.06 12.011 30.68 

2 11.832 13.99 3.643 29.461 

3 9.565 14.66 0.681 24.907 

4 11.66 14.91 3.901 30.468 

5 18.4 9.32 0.184 27.903 

T1.2 1 12.95 5.00 3.68 21.63 

2 11.45 3.94 3.10 18.50 

3 14.46 10.55 6.65 31.66 

4 11.99 4.14 7.01 23.14 

5 8.29 5.27 4.03 17.60 

T1.3 1 7.745 5.48 3.41 16.635 

2 9.049 9.20 3.067 21.311 

3 12.219 5.64 0.49 18.348 

4 19.977 15.05 5.161 40.187 

5 10.802 9.51 17.509 37.817 

T1.4 1 15.84 1.13 1.12 18.09 

2 14.78 7.59 1.92 24.30 

3 25.13 6.74 1.36 33.23 

4 13.59 9.68 1.66 24.93 

5 16.91 6.71 2.14 25.76 

T2.1 1 10.91 9.49 13.65 34.06 

2 12.05 3.69 20.25 35.99 

3 12.03 2.70 22.67 37.40 

4 13.95 4.39 18.66 37.00 

5 21.37 11.26 15.70 48.33 

T2.3 1 17.63 6.78 13.45 37.86 

2 11.37 8.91 7.99 28.27 

3 13.21 9.91 12.75 35.86 

4 16.12 7.72 11.09 34.93 

5 17.26 6.72 12.63 36.61 

T2.4 1 23.10 4.07 3.98 31.14 

2 14.18 15.05 4.69 33.91 

3 14.30 7.71 0.56 22.57 

4 13.50 11.40 4.20 29.10 

5 17.82 11.17 3.53 32.52 

T2.5 1 15.52 10.49 7.05 33.05 

2 15.71 11.49 9.14 36.34 
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3 15.71 5.88 14.67 36.26 

4 5.32 5.87 25.63 36.82 

5 8.55 5.82 20.64 35.01 

T3.1 1 10.15 8.90 16.65 35.70 

2 11.61 9.45 16.85 37.90 

3 11.11 13.97 13.05 38.13 

4 11.71 10.71 13.98 36.39 

5 15.31 7.05 14.89 37.24 

T3.2 1 11.81 12.06 13.51 37.38 

2 14.85 9.22 13.79 37.85 

3 11.88 9.72 14.28 35.89 

4 11.11 5.98 15.70 32.78 

5 12.40 8.84 17.58 38.82 

T3.3 1 13.99 4.49 19.80 38.28 

2 13.14 10.74 16.44 40.31 

3 15.70 6.21 17.93 39.84 

4 18.73 6.62 8.03 33.38 

5 13.34 14.82 14.10 42.26 

T3.4 1 11.342 14.11 9.176 34.626 

2 15.207 11.95 11.271 38.426 

3 21.145 10.06 10.11 41.314 

4 12.066 14.03 6.639 32.736 

5 14.09 13.46 5.83 33.38 

T4.1 1 18.17 18.66 8.47 45.30 

2 13.80 14.80 12.85 41.45 

3 11.08 17.57 16.85 45.50 

4 9.80 19.69 15.11 44.60 

5 14.10 14.79 14.10 42.99 

T4.2 1 4.83 9.39 26.26 40.48  
2 6.66 13.24 20.31 40.21 

3 4.83 21.73 13.13 39.69 

4 10.07 10.65 19.28 39.99 

5 12.93 6.00 20.68 39.61 

T4.3 1 8.88 1.61 44.28 54.76 

2 7.11 20.02 34.21 61.33 

3 7.78 10.97 42.58 61.33 

4 7.36 29.11 24.86 61.33 

5 14.14 21.23 8.41 43.78 

T4.4 1 6.89 14.40 32.01 53.30 

2 7.21 14.27 31.47 52.95 

3 7.60 20.50 24.07 52.16 
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4 7.19 18.12 23.96 49.27 

5 9.88 20.32 23.00 53.20 

 

b. Data skoring histologi ekspresi VEGF 

Nama 

Kelompok 

Lapang 

Pandang 

Luas Area Ekspresi VEGF 

Lemah sedang kuat total Rerata 

K+1 1 11.21 29.756 48.231 89.19 

81.64 

2 18.61 19.958 40.527 79.10 

3 15.28 12.328 44.163 71.77 

4 15.33 19.858 49.305 84.49 

5 15.17 22.82 45.645 83.64 

K+2 1 25.71 13.306 3.249 42.26 

42.26 

2 25.68 11.566 7.389 44.63 

3 27.73 4.386 6.459 38.58 

4 30.39 4.994 6.282 41.67 

5 24.84 8.986 10.359 44.19 

K+3 1 12.04 6.57 52.491 71.10 

48.61 

2 10.18 4.138 34.788 49.11 

3 16.01 7.042 14.544 37.60 

4 7.17 10.768 24.243 42.18 

5 12.22 7.448 23.37 43.04 

K+4 1 10.29 9.466 55.749 75.51 

75.82 

2 10.43 9.05 67.62 87.10 

3 12.08 17.686 38.658 68.42 

4 14.53 0.89 61.065 76.49 

5 12.26 20.426 38.871 71.56 

K-1 1 9.41 11.604 28.968 49.98 

49.49 

2 8.17 15.992 25.953 50.12 

3 12.42 16.926 34.401 63.75 

4 12.59 13.166 24.993 50.75 

5 25.54 6.078 1.251 32.87 

K-2 1 9.90 5.284 20.037 35.22 

44.74 

2 11.40 5.448 26.13 42.98 

3 10.04 11.174 22.986 44.20 

4 9.78 6.972 25.884 42.64 

5 7.66 10.912 40.062 58.64 

K-3 1 10.49 26.708 25.731 62.93 

47.61 2 11.35 8.298 29.325 48.98 

3 9.36 12.768 32.067 54.19 
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4 11.29 8.438 16.032 35.76 

5 8.48 10.674 17.034 36.18 

K-4 1 17.42 11.67 12.033 41.12 

29.53 

2 7.65 10.436 7.56 25.64 

3 8.46 13.73 0.072 22.26 

4 14.11 0.674 16.533 31.32 

5 9.52 4.23 13.542 27.29 

T1.1 1 11.612 14.116 36.033 61.76 

48.84 

2 11.832 27.972 10.929 50.73 

3 9.565 29.322 2.043 40.93 

4 11.66 29.814 11.703 53.18 

5 18.4 18.638 0.552 37.59 

T1.2 1 12.95 9.99 11.037 33.98 

38.07 

2 11.45 7.876 9.312 28.64 

3 14.46 21.108 19.941 55.51 

4 11.99 8.276 21.039 41.31 

5 8.29 10.546 12.102 30.94 

T1.3 1 7.745 10.96 10.23 28.94 

47.69 

2 9.049 18.39 9.201 36.64 

3 12.219 11.278 1.47 24.97 

4 19.977 30.098 15.483 65.56 

5 10.802 19.012 52.527 82.34 

T1.4 1 15.84 2.266 3.351 21.46 

34.91 

2 14.78 15.184 5.757 35.73 

3 25.13 13.482 4.089 42.70 

4 13.59 19.36 4.971 37.92 

5 16.91 13.428 6.414 36.75 

T2.1 1 10.91 18.978 40.962 70.85 

81.23 

2 12.05 7.38 60.75 80.18 

3 12.03 5.4 68.001 85.43 

4 13.95 8.778 55.986 78.71 

5 21.37 22.522 47.1 90.99 

T2.3 1 17.63 13.566 40.341 71.54 

65.88 

2 11.37 17.82 23.973 53.17 

3 13.21 19.81 38.244 71.26 

4 16.12 15.436 33.267 64.83 

5 17.26 13.44 37.89 68.59 

T2.4 1 23.10 8.142 11.925 43.16 

46.51 
2 14.18 30.096 14.061 58.33 

3 14.30 15.42 1.686 31.40 

4 13.50 22.802 12.609 48.91 
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5 17.82 22.332 10.596 50.75 

T2.5 1 15.52 20.974 21.135 57.62 

74.26 

2 15.71 22.97 27.432 66.11 

3 15.71 11.76 44.022 71.49 

4 5.32 11.738 76.899 93.96 

5 8.55 11.644 61.917 82.11 

T3.1 1 10.15 17.804 49.938 77.90 

77.25 

2 11.61 18.898 50.535 81.04 

3 11.11 27.934 39.162 78.21 

4 11.71 21.412 41.928 75.05 

5 15.31 14.09 44.664 74.06 

T3.2 1 11.81 24.114 40.539 76.46 

75.65 

2 14.85 18.436 41.37 74.65 

3 11.88 19.444 42.846 74.17 

4 11.11 11.95 47.103 70.16 

5 12.40 17.686 52.731 82.82 

T3.3 1 13.99 8.974 59.409 82.37 

77.91 

2 13.14 21.478 49.308 83.92 

3 15.70 12.428 53.799 81.92 

4 18.73 13.242 24.087 56.06 

5 13.34 29.636 42.303 85.28 

T3.4 1 11.342 28.216 27.528 67.09 

66.03 

2 15.207 23.896 33.813 72.92 

3 21.145 20.118 30.33 71.59 

4 12.066 28.062 19.917 60.05 

5 14.09 26.922 17.487 58.50 

T4.1 1 18.17 37.32 25.41 80.90 

88.02 

2 13.80 29.59 38.55 81.94 

3 11.08 35.146 50.556 96.78 

4 9.80 39.386 45.318 94.50 

5 14.10 29.586 42.288 85.97 

T4.2 1 4.83 18.786 78.771 102.39 

92.06 

2 6.66 26.484 60.927 94.07 

3 4.83 43.456 39.378 87.67 

4 10.07 21.292 57.828 89.19 

5 12.93 11.996 62.043 86.97 

T4.3 1 8.88 3.216 132.84 144.93 

134.83 

2 7.11 40.034 102.618 149.76 

3 7.78 21.946 127.725 157.45 

4 7.36 58.214 74.586 140.16 

5 14.14 42.452 25.23 81.82 
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T4.4 1 6.89 28.8 96.03 131.72 

123.50 

2 7.21 28.532 94.407 130.15 

3 7.60 40.992 72.195 120.79 

4 7.19 36.242 71.883 115.31 

5 9.88 40.644 69.009 119.53 
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Lampiran 4.4 Uji Analisis Statistik 

 

 

 

 

 

 

 

 

 

 

 

 

 

Descriptives 

 Dosis_fraksi Statistic Std. Error 

Ekspresi

_VEGF 

Kontrol 

negatif 

Mean 42.8425 4.54369 

95% Confidence Interval for 

Mean 

Lower 

Bound 

28.3824 
 

Upper 

Bound 

57.3026 
 

5% Trimmed Mean 43.2128  

Median 46.1750  

Variance 82.580  

Std. Deviation 9.08738  

Minimum 29.53  

Maximum 49.49  

Range 19.96  

Interquartile Range 15.69  

Skewness -1.733 1.014 

Kurtosis 3.065 2.619 

12,5 mg Mean 42.3775 3.46776 

95% Confidence Interval for 

Mean 

Lower 

Bound 

31.3415 
 

Upper 

Bound 

53.4135 
 

5% Trimmed Mean 42.4333  

Median 42.8800  

Case Processing Summary 

 

Dosis_fraksi 

Cases 

 
Valid Missing Total 

 
N Percent N Percent N Percent 

Ekspresi

_VEGF 

Kontrol negatif 4 100.0% 0 0.0% 4 100.0% 

12,5 mg 4 100.0% 0 0.0% 4 100.0% 

25 mg 4 100.0% 0 0.0% 4 100.0% 

50 mg 4 100.0% 0 0.0% 4 100.0% 

100 mg 4 100.0% 0 0.0% 4 100.0% 

Kontrol positif 4 100.0% 0 0.0% 4 100.0% 
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Variance 48.102  

Std. Deviation 6.93553  

Minimum 34.91  

Maximum 48.84  

Range 13.93  

Interquartile Range 12.85  

Skewness -.153 1.014 

Kurtosis -4.864 2.619 

25 mg Mean 66.9700 7.50717 

95% Confidence Interval for 

Mean 

Lower 

Bound 

43.0788 
 

Upper 

Bound 

90.8612 
 

5% Trimmed Mean 67.3144  

Median 70.0700  

Variance 225.430  

Std. Deviation 15.01434  

Minimum 46.51  

Maximum 81.23  

Range 34.72  

Interquartile Range 28.14  

Skewness -1.040 1.014 

Kurtosis .892 2.619 

50 mg Mean 74.2100 2.76763 

95% Confidence Interval for 

Mean 

Lower 

Bound 

65.4022 
 

Upper 

Bound 

83.0178 
 

5% Trimmed Mean 74.4589  

Median 76.4500  

Variance 30.639  

Std. Deviation 5.53527  

Minimum 66.03  

Maximum 77.91  

Range 11.88  

Interquartile Range 9.31  

Skewness -1.830 1.014 

Kurtosis 3.382 2.619 
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100 mg Mean 109.6025 11.55823 

95% Confidence Interval for 

Mean 

Lower 

Bound 

72.8191 
 

Upper 

Bound 

146.3859 
 

5% Trimmed Mean 109.4000  

Median 107.7800  

Variance 534.370  

Std. Deviation 23.11645  

Minimum 88.02  

Maximum 134.83  

Range 46.81  

Interquartile Range 42.97  

Skewness .177 1.014 

Kurtosis -4.698 2.619 

Kontrol 

positif 

Mean 62.0825 9.77094 

95% Confidence Interval for 

Mean 

Lower 

Bound 

30.9870 
 

Upper 

Bound 

93.1780 
 

5% Trimmed Mean 62.0972  

Median 62.2150  

Variance 381.885  

Std. Deviation 19.54187  

Minimum 42.26  

Maximum 81.64  

Range 39.38  

Interquartile Range 36.34  

Skewness -.014 1.014 

Kurtosis -5.060 2.619 
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Tests of Normality 

 

Dosis_fraksi 

Kolmogorov-Smirnova Shapiro-Wilk 

 
Statistic df Sig. Statistic df Sig. 

Ekspresi

_VEGF 

Kontrol negatif .333 4 . .813 4 .128 

12,5 mg .278 4 . .865 4 .279 

25 mg .221 4 . .943 4 .674 

50 mg .353 4 . .773 4 .062 

100 mg .276 4 . .873 4 .308 

Kontrol positif .259 4 . .871 4 .302 

a. Lilliefors Significance Correction 

 

 
 

 

Test of Homogeneity of Variances 

 Levene Statistic df1 df2 Sig. 

Ekspresi_

VEGF 

Based on Mean 6.717 5 18 .001 

Based on Median 5.088 5 18 .004 

Based on Median and with 

adjusted df 

5.088 5 10.875 .012 

Based on trimmed mean 6.586 5 18 .001 
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ANOVA 

Ekspresi_VEGF   

 Sum of Squares df Mean Square F Sig. 

Between Groups 12313.750 5 2462.750 11.340 .000 

Within Groups 3909.021 18 217.168   

Total 16222.771 23    

 

 

Multiple Comparisons 

Dependent Variable:   Ekspresi_VEGF   

LSD   

(I) Dosis_fraksi (J) Dosis_fraksi 

Mean Difference 

(I-J) Std. Error Sig. 

95% Confidence 

Interval 

Lower 

Bound 

Upper 

Bound 

Kontrol negatif 12,5 mg .46500 10.42036 .965 -21.4274 22.3574 

25 mg -24.12750* 10.42036 .033 -46.0199 -2.2351 

50 mg -31.36750* 10.42036 .008 -53.2599 -9.4751 

100 mg -66.76000* 10.42036 .000 -88.6524 -44.8676 

Kontrol positif -19.24000 10.42036 .081 -41.1324 2.6524 

12,5 mg Kontrol negatif -.46500 10.42036 .965 -22.3574 21.4274 

25 mg -24.59250* 10.42036 .030 -46.4849 -2.7001 

50 mg -31.83250* 10.42036 .007 -53.7249 -9.9401 

100 mg -67.22500* 10.42036 .000 -89.1174 -45.3326 

Kontrol positif -19.70500 10.42036 .075 -41.5974 2.1874 

25 mg Kontrol negatif 24.12750* 10.42036 .033 2.2351 46.0199 

12,5 mg 24.59250* 10.42036 .030 2.7001 46.4849 

50 mg -7.24000 10.42036 .496 -29.1324 14.6524 

100 mg -42.63250* 10.42036 .001 -64.5249 -20.7401 

Kontrol positif 4.88750 10.42036 .645 -17.0049 26.7799 

50 mg Kontrol negatif 31.36750* 10.42036 .008 9.4751 53.2599 

12,5 mg 31.83250* 10.42036 .007 9.9401 53.7249 

25 mg 7.24000 10.42036 .496 -14.6524 29.1324 

100 mg -35.39250* 10.42036 .003 -57.2849 -13.5001 

Kontrol positif 12.12750 10.42036 .260 -9.7649 34.0199 

100 mg Kontrol negatif 66.76000* 10.42036 .000 44.8676 88.6524 

12,5 mg 67.22500* 10.42036 .000 45.3326 89.1174 

25 mg 42.63250* 10.42036 .001 20.7401 64.5249 
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50 mg 35.39250* 10.42036 .003 13.5001 57.2849 

Kontrol positif 47.52000* 10.42036 .000 25.6276 69.4124 

Kontrol positif Kontrol negatif 19.24000 10.42036 .081 -2.6524 41.1324 

12,5 mg 19.70500 10.42036 .075 -2.1874 41.5974 

25 mg -4.88750 10.42036 .645 -26.7799 17.0049 

50 mg -12.12750 10.42036 .260 -34.0199 9.7649 

100 mg -47.52000* 10.42036 .000 -69.4124 -25.6276 

*. The mean difference is significant at the 0.05 level. 
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Lampiran 4.5 Dokumentasi Penelitian 

a. Proses Ekstraksi dan Fraksinasi 

 

(1) Penimbangan simplisia umbi 

bidara upas 

 

(2) Ekstraksi dengan 

menggunakan etanol 70% 

 

(3) Ekstraksi dengan metode 

ultrasound 

 

 

(4) Penyaringan dengan 

penyaring Bunchner 

 

(5) Pemekatan fraksi dengan rotary 

evaporator 

 

(6) Hasil fraksinasi umbi 

bidara upas 
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b. Perlakuan pada hewan coba 

 

 

(1) Persiapan kendang untuk hewan 

coba 

 

(2) Penutup pada kandang 

hewan coba 

 

(3) Pengukuran berat badan hewan 

coba 

 

 

 

 

(4) Pengukuran GDA pada 

hewan coba 

 

(5) Induksi STZ pada hewan coba 

 

(6) Pemberian dekstrosa 10% pada 

hewan coba 
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(6) Bahan untuk anestesi hewan coba 

 

(7) Pemangkasan bulu pada 

hewan coba 

 

(8) Eksisi kulit pada hewan coba 

 

(9) Hasil eksisi kulit 

 

(10) Pengambilan jaringan kulit 

 

(11) Penyimpanan jaringan kulit 
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(12) Preparat imunohistokimia 

 

(13) Hasil pengecatan 

imunohistokimia 
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Lampiran 4.6 Surat Rekomendasi Bebas Plagiasi 
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